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Preface 
 

The primary focus of any engineering laboratory/ field work in the technical education system is 

to develop the much-needed industry relevant competencies and skills. With this in view, MSBTE 

embarked on this innovative ‘K’ Scheme curricula for engineering diploma programmes with National 

Education Policy2020 (NEP2020) and outcome-based education as the focus and accordingly, relatively 

large amount of time is allotted for the practical work. This displays the great importance of laboratory 

work making each teacher; instructor and student to realize that every minute of the laboratory time need 

to be effectively utilized to develop these outcomes, rather than doing other mundane activities. 

Therefore, for the successful implementation of this outcome-based curriculum, every practical has been 

designed to serve as a ‘vehicle’ to develop this industry identified competency in every student. 

Accordingly, the ‘K’ scheme laboratory manual development team designed the practical to focus on 

the outcomes, rather than the traditional age-old practice of conducting practical to ‘verify the theory’ 

(which may become a byproduct along the way). 

This laboratory manual is designed to help all stakeholders, especially the students, teachers and 

instructors to develop in the student the pre-determined outcomes. It is expected from each student that 

at least a day in advance, they have to thoroughly read through the concerned practical procedure that 

they will do the next day and understand the minimum theoretical background associated with the 

practical. Every practical in this manual begins by identifying the competency, industry relevant skills, 

course outcomes and practical outcomes which serve as a key focal point for doing the practical. The 

students will then become aware about the skills they will achieve through procedure shown there and 

necessary precautions to be taken, which will help them to apply in solving real-world problems in their 

professional life.  

This manual also provides guidelines to teachers and instructors to effectively facilitate student-

centered lab activities through each practical exercise by arranging and managing necessary resources 

in order that the students follow the procedures and precautions systematically ensuring the achievement 

of outcomes in the students.   

The 3D modelling and additive manufacturing Laboratory Manual has been developed to help 

students understand and apply the fundamental concepts of 3D part Modelling and assembly using 

computer-aided design (CAD) software. The aim is to bridge the gap between theoretical knowledge 

and practical application by enabling students to visualize, design, and create mechanical components 

in a virtual environment. This manual provides a systematic approach to learning various Modelling 

tools and techniques used in solid Modelling. Each experiment is designed to enhance the student’s 

ability to create accurate 3D parts, assemblies, and engineering drawings. The exercises also emphasize 

understanding of geometric and dimensional constraints, feature-based Modelling, and design intent. 

The Practical manual development team wishes to thank MSBTE who took initiative in the 

development of curriculum and implementation and also acknowledge the contribution of individual 

course experts who have been involved in laboratory manual as well as curriculum development (K 

scheme) directly or indirectly. 

Although all care has been taken to check for mistakes in this laboratory manual, yet it is 

impossible to claim perfection especially as this is the first edition. Any such errors and suggestions for 

improvement can be brought to our notice and are highly welcome. 

Lab Manual Development Team 
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Program Outcomes (POs) to be achieved through Practical of this Course 

 
Following POs are expected to be achieved through the practicals of the (Theory of machines) 

course. 

PO1. Basic and Discipline specific knowledge: Apply knowledge of basic mathematics, 

science and engineering fundamentals and engineering specialization to solve the 

mechanical engineering problems.    

PO 2. Problem analysis: Identify and analyse well-defined mechanical engineering problems 

using codified standard methods.    

PO 3. Design/ development of solutions: Design solutions for well-defined technical 

problems and assist with the design of systems components or processes to meet specified 

needs in mechanical engineering.   

PO 4. Engineering Tools, Experimentation and Testing: Apply modern mechanical 

engineering tools and appropriate technique to conduct standard tests and measurements.    

PO 5. Engineering practices for society, sustainability and environment: Apply appropriate 

technology in context of society, sustainability, environment and ethical practices.    

PO 6. Project Management: Use engineering management principles individually, as a team 

member or a leader to manage projects and effectively communicate about well-defined 

engineering activities in diverse and multidisciplinary fields.   

PO 7. Life-long learning: Ability to analyse individual needs and engage in updating in the 

context of technological changes in mechanical engineering. 

List of Industry Relevant Skills-  

The following industry relevant skills of the competency Use 3D Modelling and Additive 

Manufacturing are expected to be developed in you by undertaking the practical of this 

laboratory manual. 

a. Prepare 2D Drawings using sketcher workbench of any parametric CAD software. 

b. Generate 3D Solid models from 2D sketches using Part workbench of any parametric 

CAD software. 

c. Prepare assemblies of part models using Assembly workbench of any parametric CAD 

software. 

d. Generate orthographic views of 3D solid models/assemblies using drafting workbench of 

any parametric CAD software. 

e. Generate production drawings for given part models/assemblies. 

f. Print components using 3D Printer/Rapid prototyping machine. 
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Practical- Course Outcome matrix 
Course Outcomes (COs) 

• CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

• CO2 - Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

• CO3 - Prepare assembly of part models using given 3D Modelling software. 

• CO4 - Plot a drawing for given part model/ assembly. 

• CO5 - Prepare components of assembly using 3D printer/ rapid prototyping machine. 

Sr. 

No. 
Laboratory Practical Titles 

CO

1 

CO

2 

CO

3 

CO

4 

CO

5 

1 
*Preparing drawing template consisting of name plate, 

boundary lines and projection symbols. 
√ - - - - 

2 
Drawing and plotting two simple 2D geometries using 

sketcher commands. 
√ - - √ - 

3 
*Drawing and plotting the given two simple 3-D drawings 

using 3D Modelling commands. 
√ √ - √ - 

4 
Drawing and plotting the given two complex 3D drawings 

using 3D Modelling commands. 
√ √ - √ - 

5 

*Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-I)  

√ √ - √ - 

6 

*Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-I continued) 

√ √ - √ - 

7 

*Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-I continued) 

√ √  √ - 

8 

*Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-I continued). 

√ √  √ - 

9 

*Assembly and plotting the orthographic views of the 

assembly, bill of materials of Bench vice/ Drill Jig/ Screw 

Jack/ Tool Post/ any assembly consisting of at least five parts. 

(Problem-I) 

√ √ √ √ - 

10 

Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-II) 

√ √  √ - 

11 
Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 
√ √ - √ - 
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Sr. 

No. 
Laboratory Practical Titles 

CO

1 

CO

2 

CO

3 

CO

4 

CO

5 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-II continued) 

12 

Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-II continued) 

√ √  √ - 

13 

Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ 

Screw Jack/ Tool Post/ any assembly consisting of at least 

five parts. (Problem-II continued) 

√ √ - √ - 

14 

Assembly and plotting the orthographic views of the 

assembly, bill of materials of Bench vice/ Drill Jig/ Screw 

Jack/ Tool Post/ any assembly consisting of at least five parts. 

(Problem-II) 

√ √ √ √ - 

15 
*Printing any one component from above assembly using 

3Dprinter/ Rapid prototyping machine. 
- - - - √ 
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Guidelines to Teachers 
1. Teacher need to ensure that a dated log book for the whole semester, apart from the laboratory 

manual is maintained by every student which s/he has to submit for assessment to the teacher in 

the next practical session. 

2. There will be two sheets of blank pages after every practical for the student to report other matters 

(if any), which is not mentioned in the printed practical. 

3. For difficult practical if required, teacher could provide the demonstration of the practical 

emphasizing of the skills which the student should achieve. 

4. Teachers should give opportunity to students for hands-on after the demonstration. 

5. Assess the skill achievement of the students and COs of each unit. 

6. One or two questions ought to be added in each practical for different batches. For this teacher can 

maintain various practical related question banks for each course. 

7. If some repetitive information like data sheet, use of software tools etc. has to be provided for 

effective attainment of practical outcomes, they can be incorporated in Appendix. 

8. For effective implementation and attainment of practical outcomes, teacher ought to ensure that in 

the beginning itself of each practical, students must read through the complete write-up of that 

practical sheet. 

9. During practical, ensure that each student gets chance and takes active part in taking observations/ 

readings and performing practical. 

10. Teacher ought to assess the performance of students continuously according to the   MSBTE 

guidelines 

 

Instructions for Students 

 

1. For incidental writing on the day of each practical session every student should maintain a dated 

log book for the whole semester, apart from this laboratory manual which s/he has to submit for 

assessment to the teacher in the next practical session. 

2. For effective implementation and attainment of practical outcomes, in the beginning itself of each 

practical, students need to read through the complete write-up including the practical related 

questions and assessment scheme of that practical sheet. 

3. Student ought to refer the data books, IS codes, Safety norms, Technical Manuals, etc. 

4. Student should not hesitate to ask any difficulties they face during the conduct of practical.  

  



 3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education           K Scheme  

vi 

 

Content Page 

List of Practical and Progressive Assessment Sheet 

Sr. 

No 

Laboratory Practical Titles 

 

Pag

e 

No. 

Date of 

performa

nce 

Date of 

submis

sion 

FA PR 

marks 

(25) 

Dated 

sign. of 

teacher 

Rema

rks (if 

any) 

1 

*Preparing drawing template 

consisting of name plate, boundary 

lines and projection symbols. 

1 

   

 

 

2 

Drawing and plotting two simple 

2D geometries using sketcher 

commands. 

22 

   

 

 

3 

*Drawing and plotting the given 

two simple 3-D drawings using 3D 

Modelling commands. 

31 

   

 

 

4 

Drawing and plotting the given two 

complex 3D drawings using 3D 

Modelling commands. 

46 

   

 

 

5 

*Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw 

Jack/ Tool Post/ any assembly 

consisting of at least five parts. 

(Problem-I)  

63 

   

 

 

6 

*Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw 

Jack/ Tool Post/ any assembly 

consisting of at least five parts. 

(Problem-I continued) 

74 

   

 

 

7 

*Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw 

Jack/ Tool Post/ any assembly 

consisting of at least five parts. 

(Problem-I continued) 

83 

   

 

 

8 

*Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw Jack/ 

Tool Post/ any assembly consisting 

of at least five parts. (Problem-I 

continued). 

95 

   

 

 

9 

*Assembly and plotting the 

orthographic views of the assembly, 

bill of materials of Bench vice/ Drill 

Jig/ Screw Jack/ Tool Post/ any 

assembly consisting of at least five 

parts. (Problem-I) 

107 
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Sr. 

No 

Laboratory Practical Titles 

 

Pag

e 

No. 

Date of 

performa

nce 

Date of 

submis

sion 

FA PR 

marks 

(25) 

Dated 

sign. of 

teacher 

Rema

rks (if 

any) 

1. 10 

Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw Jack/ 

Tool Post/ any assembly consisting 

of at least five parts. (Problem-II) 

116 

   

 

 

2. 11 

Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw Jack/ 

Tool Post/ any assembly consisting 

of at least five parts. (Problem-II 

continued) 

129 

   

 

 

3. 12 

Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw Jack/ 

Tool Post/ any assembly consisting 

of at least five parts. (Problem-II 

continued) 

137 

   

 

 

4. 13 

Drawing and plotting the 

production drawing of the 3D part 

models of individual components of 

Bench vice/ Drill Jig/ Screw Jack/ 

Tool Post/ any assembly consisting 

of at least five parts. (Problem-II 

continued) 

144 

   

 

 

5. 14 

Assembly and plotting the 

orthographic views of the assembly, 

bill of materials of Bench vice/ Drill 

Jig/ Screw Jack/ Tool Post/ any 

assembly consisting of at least five 

parts. (Problem-II) 

152 

   

 

 

6. 15 

*Printing any one component from 

above assembly using 3Dprinter/ 

Rapid prototyping machine. 

160 

   

 

 

 

 

Note: To be transferred to Proforma of CIAAN-2023. 

A suggestive list of LLOs is given in the above table. More such LLOs can be added to attain the 

COs and competency. A judicial mix of minimum 12 or more practical need to be performed, out 

of which, the practical marked as ‘*’ are compulsory, so that the student reaches the ‘Precision 

Level’ of Dave’s ‘Psychomotor Domain Taxonomy’ as generally required by the industry. 
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Practical No.01   *Preparing drawing template consisting of name plate, boundary 

lines and projection symbols. 

I. Practical Significance 

Creating a drawing template that includes a name plate, boundary lines, and projection symbols 

is a fundamental step in technical drawing or engineering graphics. This setup has practical 

significance for clarity, standardization, and communication across engineering disciplines. 

II. Industry/Employer Expected Outcome (s) 

The trainee should be able to prepare a standardized drawing template that includes a properly 

formatted nameplate, boundary lines, and projection symbols. This ensures clarity, professionalism, 

and adherence to industry drafting standards for technical documentation. Standardized Drawing 

Format 

III.     Course Level Learning Outcome (CO) 

     CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

IV.    Laboratory Learning Outcome(s) 

1. Understand the components of a drawing template: 

• Identify and explain the significance of name plates, boundary lines, and projection symbols in 

engineering and technical drawings. 

2.  Prepare a standardized drawing template: 

• Accurately create boundary lines with correct spacing and thickness according to drawing 

standards. 

• Design and position the name plate with all necessary information such as title, scale, date, and 

drafter’s name. 

 3. Apply projection symbol conventions: 

• Draw and place projection symbols (First angle and Third angle projection) correctly on the 

template. 

• Understand the difference between projection methods and their representation in the drawing 

template. 

4. Adhere to drawing standards and practices: 

• Apply relevant engineering drawing standards (such as ISO or ANSI) while preparing the 

template. 

• Ensure clarity, neatness, and accuracy in the drawing layout to facilitate communication. 

5. Prepare a reusable template for consistent use: 

• Create a template that can be reused for multiple drawing exercises, ensuring uniformity and 

time efficiency in future drawings. 

V.   Relative Affective Domain Related Outcome(s)- 

• Working in team work. 

• Follow ethical Practices. 

VI. Minimum Theoretical Background with diagram 

• Basic knowledge of computer handling. 
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• Basic knowledge geometric constructions. 

• Reading of engineering drawing. 

• Basic knowledge of sketcher environment. 

VII. Experimental setup  

To create a drawing template consisting of a name plate, boundary lines, and projection symbols 

using any parametric Solid Modelling software parametric software. 

VIII. Resources Required 

 

S. 
No. 

Name of 

Resource 

Suggested Broad Specification Quantity 

 

1 
Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; A3 / 

A4 size printer / plotter. 

Display-wide Screen preferably. 

As per batch size 

2 
Operating system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 
As per batch size 

3 Software Any parametric solid Modelling software. As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX.  Procedure 

The first things you need to do if you want own customized format is to decide what it is 

going to look like. The best way to do that is to draw one out roughly on the relevant sized 

sheet of paper. As an example, we are going to create an A4 sized landscape custom based 

template format (Here Solid Modelling CAD software is used). This is the guide to help 

you. You now have to determine how each element will be made. Considering following 

specifications of sample template for exercise as shown in Figure. 

 

Problem Definition: Paper Size- A4 (297 X210 mm) Name Plate Size -150 X50 mm. 

Border-277X190mm 
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Sr. 
No. Particular Color Width Height Thick 

Font/Alignment in 
cell 

1 
Border (Inside offset 
by 10 mm 

Black 1 -- -- 
-- 

2 Table Lines Brown 0.5 -- -- -- 

3 

NAME, ROLL NO, 

SEM.& SEC., SUB 

DATE, GRADE, 

SHEET 
NO. CECKED BY 

Red 

 

-- 

 

4 

 

1 CG Times. 

Horizontally left. 

Vertically middle 

4 

SCREW 

JACK 

ASSEMBL

Y 

Green 
-- 4 1 

CG Times. 

Horizontally center. 
Vertically middle 

5 

INSTITUTE 

NAME 

DEPARTMENT 

NAME 

Light 

Blue 

-- 4 1 
CG Times. 

Horizontally center. 
Vertically middle 

6 
First Angle Symbol 
Øԁ = 9 

Black 0.5 -- -- 
Line font-SOLID 

FONT, CTRL FONT 

7 

Note-ALL 

DIMENSIONS ARE 

IN MM 

Dark 

Blue -- 4 1 CG Times 

Following steps are required to create an A4 sized landscape custom based template format. (Here 

you can use any CAD software) 
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A. Setting the Environment: 

1. Click on  icon on the desktop. The software will be launched, and the first 

window will be displayed as shown in Figure. 

B. Set working directory: 

To store all the created work content (files) in the current session in a specified folder; 

initially we have to set the directory. You can set any existing folder as the working 

directory. To do this, click File>Manage Session>Select Working Directory, select 

the particular folder. 

 

 

After setting specified directory, the screen will appear as shown in Figure. 
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Click OK as shown in Figure. 

C. To invoke format environment: 

1. Select New from the File toolbar. The New dialog box is display. 
2. Select the format radio button. 

3. Type name as PRACTICAL1_TEMPLETE_FORMAT. 

4. Choose the OK button. 

 

When you invoke the Format mode, the new dialog box will display shown in 

Figure 
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1. Select the Empty radio button. Select landscape orientation. 

2. Specify A4 (297X210 mm) size sheet by drop down menu. 

3. Click on OK The A4 size sheet will appear as shown in Figure. 

 

D. To draw border 10 mm inside the sheet: 

1. Select Sketch from ribbon menu to draw border to the sheet. 

 

2. Select Offset Edge command from sketching tool bar. 
 

 

3. Select Ent. Chain from menu manager. 

4. Select the A4 size sheet by pressing Ctrl button of key board. 
 

 

5. Click OK from ‘select’ dialog box. 

6. Enter off set distance -10 and accept the value. Exit from commands. 
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Figure show the A4 size sheet with 10 mm border inside the sheet. 

 

E. To insert the table. 
1. Choose Table from ribbon menu. 

2. Select the table by specifying 3 columns and 5 rows as shown in 

Figure. 

3. Click curser inside the border of A4 size sheet. 

 

The table will display on the drawing area as shown in Figure. 

 

 

 

 

 

 

 

F. To convert the table to required height and width: 

1. Highlight the table by window selection method. 

2. Click to Height and width tool option. The new Height and 

Width definition dialog box will appear on the screen as shown in figure. 
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In the same dialog box- 

1. Uncheck the ‘Automatic height adjustment’ option. 

2. Mention the height 10 and width 50 in the same dialog box option. 

3. Click OK, Click the cursor in drawing area. 

The table appearance is similar to the one shown in Figure. 

G. To merge the required cell: 

1. Highlight the cells, those you want to merge by pressing Ctrl button of key board. 

2. Click on Merge Cells options from menu bar. 

3. Click the cursor in drawing area. 

The table appearance is similar to the one shown in Figure. 

 

Repeat the same procedure to merge remaining cell as per sample title block given to 

you. 

H. To move entire table to lower right corner of the border: 

1. Click on Table from menu bar. 

2. Highlight table by clicking on it. 

3. Pick up the table Grib and locate it at lower left corner of border. 

The table will look like as shown in Figure. 
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I. To add the text as per the given sample title block: 

1. Highlight a cell by double clicking. 

2. New ‘Note properties’ definition dialog box will open. 

 

 

1.  Type the text ‘NAME-' in note properties window as shown. 

 

2. Select the Text Style tab from same window. 

3. Mention Height 4, thickness 1, font CG TIMES, left, middle and red color for 

proper alignment of letter. Click on Preview and OK tab. 

The same screen will look appear as shown in Figure. 
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4. Repeat the same procedure for all letters. 

Finally, you will get the TITLE BLOCK as shown in Figure. 

To change table line width and color: 

 

3. Select Table>Select Line Style option button. 

4. Keep Modify Lines as default as it is. 

5. Select table of name plate by just clicking. 
 

 

6. Select OK 

7. New Modify Line Style definition dialog box will appear on screen. 

8. Enter required width 0.5 and brown color and click on Apply button. 
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The table line width will get changed and appear is similar to the one shown in 

Figure. 

 

To change line width and color of border lines: 

9. Select Sketcher> Line Style> Modify Lines. 

10. Then select entire border lines by pressing Ctrl button of key board. 

11. Accept your selection by clicking OK 

 

New Modify Line Style definition dialog box will appear on screen. 

 

12. Enter the width by 1 and black color. Click to Apply> Close>OK 

The border line width will get changed and appear is similar to the one shown in 

Figure. 
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J. To create FIRST ANGLE symbol in template: 

1. Select Annotate from menu bar. 

2. Select Symbol Gallery from Symbol drops down list. 

 

 

 

3. Select Define from Menu Manager. 

4. Specify symbol name as FIRST_ANGLE and accept selection. 

The next new screen will appear shown in Figure. 

 

To draw first angle projection symbol. Use tool bar shown in previous Figure. 

1. Select Sketcher>Line 
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2. Start to draw symbol. First you have to draw horizontal and vertical lines. 

3. Change line style by selecting line and click RMB. Select Line Style. 

New Modify Line Style definition dialog box will appear on screen. 

 

4. Select CTRL FONT and Black color. Click to Apply button. 

Continue the same procedure whenever you want to change the line style. 

5. Next insert  Point at intersection of two center lines as shown in Figure. 

6. Draw two circles of diameter 9 and 4.5 by using Edit Diameter Value by right 

clicking option and accept it by clicking as shown in Figure. 
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You have to draw remaining entities of symbol according to proportionate 

mention in Figure. Finally, First Angle symbol will look like as shown in Figure. 

 

To change symbol width. 

1. Select symbol by window method. 

2. Right click and choose Line Style option. 

3. Specify width by 0.5 as shown in Figure. Click Apply button. 
 

 

4. The symbol line width will change as shown in Figure. Next click on Done 

from the Menu manager. 

 

New window Symbol Definition Attribute dialog box will display on the screen 

as shown in Figure. 
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5. Tick the Free option and click on OK. 

 

New Select Point definition dialog box will open. 

6. Select a point using absolute co-ordinates option. Click on OK 

Again, window Symbol Definition Attribute will display on the screen. Click 

on OK. 

7. Select Done option from Menu Manager. 

 

 

Now you will be at main screen as shown in Figure. 
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8. Select Done option from Menu Manager. 

First Angle symbol is created in Custom Symbol. 

K. To insert prepared first angle projection symbol in name plate: 

1. Select Annotate> Symbol>Custom Symbol from menu New Custom Drawing  

2. Symbol window will display on screen. 

3. Select FIRST_ANGLE as the symbol name from the list as shown in Figure. 

4. Now click on actual symbol and place it in drawing area by moving cursor as 

shown in Figure. Click on OK. 
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5. Move the symbol at required position. 

 

Finally sheet with symbol will look like as shown in Figure. 

 

L. To add note without leader: 

1. Click Annotate tab, select Note button Note and click Make Note options 

from Menu Manager. 
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New Select Point window will appear on the screen. 

1. Choose Free point and locate it as per requirement. 

2. Write note as ALL DIMENSIONS ARE IN MM and accept it. 

3. Select Done from Menu Manager. 

4. Right click on letters you written. Select Properties option. 

 

Note Properties window will open. 

 

5. Specify font as CG Times, Height 4, Thickness 1, blue color. Select 

Preview. Click OK button. Finally mentioned note will look like as shown 

in Figure. 

M. To change sheet name Lines & Lettering by SCREW JACK ASSEMBLY: 

1. Double click to respective cell. Note Properties window will display. 

2. Type SCREW JACK ASSEMBY in Text option. 
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3. Select Text Style tab, and enter the font-4, Thickness -1, horizontally center and 

vertically middle alignment. Color –green. 

 

4. Click Preview and OK. 

Finally, the A4 size landscape custom based template format will ready as 

shown in Figure. 

 

 

N. Save the work by clicking the Save button. The A4 size custom based template format 

stored in working directory and we can use it for further work. 

 

X. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

1. List the different menu bar used in software. 

2. Write the purpose of Title block in drawing sheet. 

3. Explain information mention in title block. 

 

[Space for Answer] 
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XI. References / Suggestions for Further Reading 

o https://www.youtube.com/watch?v=B96jGGkt-zk 

o https://www.youtube.com/watch?v=cWCI8Klji80 

o https://www.youtube.com/watch?v=zJrea53xtG8 

XII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No. 02  Drawing and plotting two simple 2D geometries using sketcher    

Commands. 

I. Practical Significance 

To create a 3D feature, it is necessary to draw its 2D sketch. In the sketcher environment 

the sketch of the feature is created, dimensions and constrains are provided to sketch. 

The designer can make to make sure that the 2D sketch of the product is satisfying the 

necessary conditions, then continue to create 3D model of the product in the part mode. 

II. Industry/Employer Expected Outcome (s) 

• Accurate 2D Geometry Creation – Ability to create precise basic shapes (e.g., 

rectangle, circle) using sketcher tools. 

• Efficient Use of Sketcher Commands – Proficient use of line, arc, trim, dimension, 

and constraint tools. 

• Understanding of Geometric Constraints – Apply and modify constraints to control 

shape and size. 

• Basic CAD Proficiency – Demonstrate familiarity with CAD or Any parametric solid 

Modelling software environment. 

• Interpretation of Technical Drawings – Read and replicate basic geometry from a 

given technical sketch or drawing. 

III. Course Level Learning Outcome (CO) 

                         CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

        CO4- Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

             By the end of the lab, students will be able to: 

1. Use basic sketcher commands to draw two simple 2D geometries. 

2. Apply geometric and dimensional constraints to fully define sketches. 

3. Identify and correct under- or over-constrained sketches. 

4. Save and plot the final drawings accurately 

V. Relative Affective Domain Related Outcome(s)- 

Demonstrates willingness to engage in sketching tasks with accuracy and patience, showing 

appreciation for the role of precision in geometric design. 
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VI. Minimum Theoretical Background with diagram 

Sketcher is a 2D drawing workspace used in CAD software (like CATIA, AutoCAD, or 

Solid Works or Any parametric solid Modelling software.) to create the base profile for 3D 

models. It includes basic commands to draw and constrain shapes 

VII. Experimental setup  

Use Sketcher module in CAD or Any parametric solid Modelling software to draw and 

constrain two simple geometries. 

VIII. Required Resources /Apparatus/Equipment with specification. 

 

Sr. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

 Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 

GB; A3 / A4 size printer / 

plotter. 

Display-wide Screen preferably. 

As per batch size 

2 
Operating 

system 

Windows XP/Windows 7/ 

Windows 

8/Windows 10 or higher. 

As per batch size 

3 Software 
Any parametric solid Modelling 

software. 
As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

 

IX. Precautions to be Followed 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While constructing the drawing, periodically save your work. 

 

X.  Procedure  

Exercise No.1-Rerdaw the given 2D geometries. 
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                                                                Fig. 2.1 Sketch of the model 

Stepwise procedure- 

The following is the stepwise procedure to draw a sketch of a given model. 

1. Start Pro/ENGINEER or any other available solid Modelling software. 

2. When the Pro/ENGINEER session started, the first task is to set the working directory. It is a 

directory on your system where you can save the work done in the current session of Pro/ 

ENGINEER. 

3. Starting a new object File, Choose the New button from the file toolbar. Any sketch drawn in the sketch 

mode is saved with .sec file extension. 

4.  Drawing the line of sketch, choose the line button from the sketcher tools tool bar. Specify the 

start point by clicking to the right in the drawing area one end of the line is attached to the cursor. 

Move the cursor down to get an approximate size of line (fig, 2.2). Notice that 

while moving a curser vertically down, a constraint appears adjacent to line. If you draw a line 

now the vertical Constraint will be applied to the line. This vertical constraint is not visible in the 

drawing area until the creation of line. 

 

 

 

                    Fig.2.2 Sketch with inclined lines                  Fig. 2.3 Partial sketch with weak dimensions

    

5. Choose the Create an arc by 3 points or tangent to an entity at its endpoint button 

From the Sketcher Tools toolbar. You are prompted to select the start point of the arc Select 
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the endpoint of the left inclined line. Move the cursor along the tangent direction through a 

small distance. A rubber-band arc that is tangent to the endpoint of the line appears. As you 

move the cursor to the end point of the right inclined line, at a particular point the tangent 

constraint is applied at both the ends of the arc. This is indicated by the symbol T that appears 

on the Endpoints of the inclined lines. 

6. As the tangent constraint appears, click to end arc creation. You will notice that the 

tangent constraint with a symbol T appears at the endpoints of the arc, as shown in Fig. 2.4. Press 

the middle mouse button to end arc creation. 

7. Note that in Figure 2.3 there are some weak dimensions that are not displayed in Figure 

2.4. This is because the weak dimensions are deleted without confirming their deletion. Hence, 

after drawing the arc some weak dimensions get deleted automatically. 

8.  Select create concentric circle button; you are prompted to select an arc. Select the arc 

by clicking on it. Move the mouse and a circle appears. To draw the circle, click to select a point 

inside the sketch. Press the middle mouse button to end circle creation. The sketch is complete 

and appears as figure 2.5. 

 

 

 

 

 

 

 

 

 

  

  

 

 

  

  

  

  

 

 

 

 

 

Fig. 2-4 Sketch with arc                             Fig. 2.5 Sketch with all entitles, weak dimensions and weak 

constraints 

 1.  ' While sketching the geometry the software automatically generates the dimensions on 

The different entities which are weak dimensions. These dimensions can be modified and made 

strong by double clicking on the individual dimensions the user can add own dimensions by using 

create defining dimension tool. After modifying the dimensions and made it strong the sketch 

completes shown on fig. 2.6. 
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Fig 2.6 The complete sketch with dimensions and constraints 

 

 

 

 

 

Exercise No.2-Rerdaw the given 2D geometries. 

• Create sketch using available solid Modelling software and attach the printout. (Any one from 

below two sketches) 

 

• Print drawing of the part: 

 

1. Prepare for Plotting 
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o Go to File → Page Setup / Print Setup. 

o Choose: 

▪ Printer/Plotter name 

▪ Paper size (A4 / A3 / A2) 

▪ Orientation (Landscape / Portrait) 

▪ Plot area: Window or Extents 

2. Set Drawing Scale 

o Choose a suitable scale (e.g., 1:1, 1:2, etc.) 

o Ensure the entire geometry fits properly in the drawing sheet. 

3. Add Dimensions and Annotations 

o Use Dimension and Text commands to label the drawing. 

o Add Title Block (Name, Date, Scale, Material, etc.). 

4. Preview the Plot 

o Go to File → Print Preview / Plot Preview. 

o Check layout, margins, and line weights. 

5. Print / Plot the Drawing 

o Go to File → Print / Plot. 

o Choose the output: 

▪ Direct to printer 

▪ Or PDF plot using “Microsoft Print to PDF” / “DWG to PDF” option. 

6. Save the File 

o Save the drawing file for record and future use. 

 

 

 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions so as to ensure the achievement of identified CO. 

 

1. Explain the purpose of using the Sketcher workbench in CAD software and describe its role 

in the 3D Modelling process. 

2. Demonstrate how to set a reference plane (XY, YZ, XZ) before starting a sketch in a CAD 

environment. Describe the steps involved. 

3. Differentiate between geometric constraints and dimensional constraints with suitable 

examples. 

4. Describe the functions of the Trim and Extend commands in sketching and explain when each 

should be used. 

5 Justify the importance of fully constraining a sketch before converting it into a 3D model. 

Discuss the consequences of under-constrained sketches. 

 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

• https://www.youtube.com/watch?v=-m1oKuFkSTE 

• https://youtu.be/IVIAjl9i1TI?si=4_qu7mP-EuRcEfYH 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No. 03 *Drawing and plotting the given two simple 3-D drawings using 

3D Modelling commands. 
I. Practical Significance 

Creating and plotting simple 3D drawings using 3D Modelling commands holds great 

practical value for students, especially those studying engineering, architecture, design, 

or related technical fields. It serves as a foundation for developing essential skills needed 

in both academics and future careers 

II. Industry/Employer Expected Outcome (s) 

1.  Accurate 3D Modelling: Ability to create precise 3D representations of simple objects 

using appropriate CAD software commands. 

2. Efficient Use of Commands: Proficiency in applying 3D Modelling tools (e.g., extrude, 

revolve, union) to build and modify models. 

3. Technical Drawing Interpretation: Understanding and translating 2D sketches or 

technical drawings into 3D models. 

4. Plotting & Documentation: Ability to generate and plot views (isometric, orthographic) 

for presentation 

III. Course Level Learning Outcome (CO) 

              CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

             CO2-Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4- Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

1. Gain hands-on experience in creating and visualizing basic 3D objects using 3D Modelling 

commands, enhancing understanding of spatial design, object manipulation, and CAD software 

tools. 

V. Relative Affective Domain Related Outcome(s)- 

Demonstrates willingness to engage in 3D Modelling tasks with attention to detail, shows 

appreciation for the precision and creativity involved in creating 3D drawings, and values the 

importance of accuracy and aesthetics in technical design. 

VI.       Minimum Theoretical Background with diagram 

• Basic knowledge of reading of 3D objects. 

• Knowledge of creating working directory. 
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VII. Experimental setup  

Start by opening your 3D Modelling software and creating a new project. Use basic 3D 

commands such as line, extrude, and rotate to draw the two simple 3D shapes. Finally, visualize 

the drawings by plotting or rendering and save the results. 

VIII. Required Resources /Apparatus/Equipment with specification. 

Sr. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

   Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; A3 

/ A4 size printer / plotter. 

Display-wide Screen preferably. 

As per batch size 

2 Operating system 
Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 
As per batch size 

3 Software 
Any parametric solid Modelling 

software. 
As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX. Precautions to be Followed 

• Student should understand and can draw at least two Orthographic views of any model. 

• While constructing 2D sketch, boundary (Area) of any profile should be enclosed. 

• While specifying dimensions, carefully select the entity or end points of entity and click 

the middle button (roller) of mouse. 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While constructing the drawing, periodically save your work. 

X.  Procedure 

A. Exercise 1. Create following given 3D part using part Modelling workbench of CAD 

software. 

 
 

Following steps are required to create given solid 3D part in part Modelling workbench. 

A. Start Solid Modelling. 
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B. Set the working directory. 

C. Start part model environment. 

D. Selecting the Sketching Plane for the Base Feature. 

E. Creating and Dimensioning the Sketch for the Base Feature. 

F. Selecting the Sketching Plane for the Second Feature. 

G. Creating and Dimensioning the Sketch for the Second Feature. 

H. Selecting the Sketching Plane for the Third Feature. 

I. Creating and Dimensioning the Sketch for the Third Feature. 

J. Save the part and close the file. 

K. Printing of part drawing. 

 

A. Start Solid Modelling parametric: As explained in practical No.01. 

B. Set Working Directory: As explained in practical No.01. 

C. Start part model environment: As explained in practical No.03 Exercise1 

 

1. Type name as PRACTICAL3_EXERCISE1.Click OK button as shown in figure. 

 

2. New File Box window will display on the screen. 

3. Then from New File options dialog box select ‘solid part mmks’ and click OK. 

4. Part Modelling workbench will display on the screen. 

 

D. Selecting the Sketching Plane for the Base Feature: 

5. Now we have to create first base feature of the given part. So, we need to draw a 

sketch of first feature on any one of the default plane. 

6.Click on Sketch button from part Modelling tool bar. Then Sketch 

window will appear as shown in Figure. 
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7. Select the correct plane as per the part orientation by just clicking on the 

default plane. Click on Sketch button 

 

 
8. Click on Orient View button to orient the view parallel to screen. 

E. Creating and Dimensioning the Sketch for the Base Feature. 

1 Activate the grid from the View option tool bar as shown in Figure. 

 

 

 

 

 

 

 

 

 

 

5. Click File>Options>Sketcher. Set the grid spacing by 5 mm as shown in 

Figure. Click OK 
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3.Select line from sketching tool bar to draw line close loop profile as shown in 

figure. 

 
4. Click MMB to exit. Weak dimensions will appear on the drawing. 

 

 

 

 

 

 

 

 

 

 

 

F. To modify a dimension double-click on its value using the LMB, and then type a 

new value as per the drawing. Accept it by clicking on green colored Check mark. 
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1 Select  button of part Modelling tool bar. 

 

2. Mention the height of 100 mm, click on to change depth direction of extrude. Click 

on  for preview, and finally click on  accept button if extrude correct 
3. Finally base feature of the part will look like as shown in Figure 
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G. Selecting the Sketching Plane for the second Feature: 

 

1 Click on Sketch button from part Modelling tool bar. Then Sketch window 

will appear. 

2 Take the cursor on the appropriate plane according to given part, and click on it. 

3 Click on Sketch of the sketch window. 

4 Click on Orient View button to orient the view parallel to screen. Then 

plane of the second feature will ready for sketching of the second feature as shown 

in Figure. 

 

 
 

H. Creating and Dimensioning the Sketch for the second Feature. 

 

1. Select from Sketching tool bar to draw rectangle 
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2. Use         constraint tool to coincident two sides of the above rectangle. 

 

 3.Select         and then select line and edge of the first features as shown in 

Figure. 

4.To modify a dimension, double-click on its value using the LMB, and then type a new 

value 20 X 50 mm as per the drawing. Accept it by clicking on green check mark. 

 

 
                        5.       Select            button of part Modelling tool bar. 
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6.  Mention the height of 40 mm, click on remove material. Click 

on  to change depth direction of extrude. Click on  for preview, and 

finally click on accept button if extrude correct. You will get second feature of 

the part as shown in Figure. 

 

 

 

 

 

 

 

 

 

I.  Selecting the Sketching Plane for the Third Feature. 

1. Click on Sketch button from part Modelling tool bar. Then Sketch 

Window will appear. 

2. Take the cursor on the first feature top plane according to given part, and click 

on it. 

                              3. Click on Sketch of the sketch window 

 

 

 

 

 

 

` 

 

 

 

 

4. Click on     Orient View button to orient the view parallel to screen. Then 

plane of the first feature will ready for sketching of the third feature as shown in 

Figure. 
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J.  Creating and Dimensioning the Sketch for the Third Feature. 

1. Select from Sketching tool bar to draw rectangle 

 

 

 

     2. Use  constraint tool to coincident two sides of the above rectangle. 

     3.  Select and then select line and edge first features as shown in Figure. 

4. To modify a dimension, double-click on its value using the LMB, and then type a   

new value 40 X 25 mm as per the drawing. Accept it by clicking on green.  
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     5. Select         z button of part Modelling tool bar 

 

 

 

 

 

 

 

 

 

 

 

                         

   6.  Mention the height of        25 mm, click on      remove material. Click 

        

on     to change depth direction of extrude. Click on       for preview,  

 

and finally click on      correct. accept button if extrude  

  

            7.    Finally, third feature of the part will look like as shown in Figure. 

8. Save the part and close the file.  

B. Exercise 2. Create sketch using available solid Modelling software and attach 

the printout  
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K.  Print drawing of the part: 

 

Step-by-Step: 

1. Set Up Layout Tab 

o Go to the Layout1 tab at the bottom. 

o Command: PAGESETUP 

o Choose your printer (e.g., “DWG To PDF.pc3” or a physical printer) 

2. Set Paper Size 

o Example: A4 (210 × 297 mm) 

3. Set Plot Area 

o In Plot Area, choose Window 

o Select your 3D model area 

4. Choose View Style 

o For shaded 3D output: Select Shaded with edges 

o For wireframe: Select Hidden 

5. Adjust Viewport 

o Use command: MV → Create a viewport on layout 

o Inside viewport, set View to Isometric 

6. Set Plot Scale 

o Typical: 1:1 or 1:2 (depending on paper) 

7. Preview Plot 

o Click Preview to verify appearance 

8. Plot / Print 

o Click OK → Choose save location (if PDF) 

o Or send directly to printer 
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XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

Questions: 

1.   Explain application of solid Modelling in industry. 

2.   List and explain different types of toolbars used in part Modelling. 

3. Differentiate between 2D sketching and 3D Modelling. 

4.  Explain how constraints and dimensions help in creating a parametric model. 

5.  State the advantages of using 3D Modelling over manual drafting. 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

1. https://www.youtube.com/watch?v=ZUPRT95V4Ek 

2. https://www.youtube.com/watch?v=OPmjH5QfiRs 

3. https://www.youtube.com/watch?v=O78bWdxjqWs 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No.04       Drawing and plotting the given two complex 3D drawings 

using 3D Modelling commands. 

I. Practical Significance 

The objective is to create solid models of mechanical components and to learn various sketching 

and modelling commands. Studying different geometric and modelling constraints. From a design 

engineer’s perspective, this allows viewing an object from multiple directions and in various views, 

ensuring that the object appears exactly as intended. Additionally, it provides insight into possible 

modifications or improvements that can be made to the design. 

II. Industry/Employer Expected Outcome (s) 

This practical is expected to develop the following skills for the industry/Employer 

1. Prepare 3D model of given object. 

2. Prepare 2D Darwing from given 3D model 

3. Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Draw the complex 3D components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Working in team work. 

• Demonstrate working as a leader/a team member. 

• Follow ethical Practices Follow ethical Practices. 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings and 3D 

models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). 

Solid Modelling Techniques- Extrusion: Extending a 2D profile to create a 3D solid, Revolution: 

Rotating a sketch around an axis to form symmetrical shapes, Sweeping & Lofting: Creating complex 

shapes by moving profiles along paths, Boolean Operations: Combining or subtracting solids (Union, 

Subtract, Intersect). Reference planes (XY, YZ, ZX) and axes are used to define model geometry 

accurately. 
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VII. Experimental setup  

 The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 

SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill jig, 

screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), plotting/printing 

tools, and reference technical 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. 

No. 
Name of Resource 

Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 
1 for each 

student 

2 3D modelling software Latest configuration 
1 for each 

student 

3 Plotter/ printer A4 size 1 

 

IX. Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor 

X. Procedure 

Problem definition: 

a. Prepare 3D part model of figure 4.1 and 4.2 

b. Generate Front View and Top view of figure 4.1 and 4.2 

 

   Fig: 4.1      Fig: 4.2 

 

1. Open solid modelling software 

2. Click on  new icon. 
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3. Click on  part icon for creating new object. 

4. Click on  setting icon located at top. 

5. Select document properties Tab and select units option. 

6. Select MMGS (millimeter, gram, seconds) for setting units in millimeter and click ok. 

7. Go to Feature manager design tree  

 
Feature manager design tree 

8. Select Front plane option located in feature manager design tree. 

 
Planes 

9. Goto to head up view toolbar for rotating view (for bringing selected view to the front) 

 

and click on  view orientation icon, then click  Normal to icon. 

10. Go to feature manager design tree, click on front plane  and click on  

sketch icon to start new sketch 
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11. Go to sketch tool bar, and select circle command and draw two concentric circle by keeping 

origin as center as shown below 

 

12. Go to sketch toolbar, click on small arrow mark in line command and select center line, 

draw center lines. 

 

            
 

13. Go to sketch toolbar, select line command, draw sketch as shown below 

 
14. Go to sketch toolbar, select trim command, trim excess parts of line  
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15. Go to sketch toolbar, select smart dimensions, give all necessary dimension to the drawing. 

 

16. Go to sketch toolbar, select  Mirror Entities, select line to mirror, select 

horizontal center line to mirror about. 

 

17. Select trim command and trim out excess parts of lines. 
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18. Go to feature toolbar, select Extruded Boss/Base, select Direction 1 as Mid Plane 

 Enter depth 80mm, click on  thick icon. 

   

 

19. Select right plane, click on sketch icon to create new sketch 

 
20. Go to sketch toolbar, prepare sketch as shown below 
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21. Go to sketch toolbar, smart dimensions, give all necessary dimensions as shown below 

 
22. Go to feature toolbar, select Extruded Boss/Base, Select Mid plane as direction 1, enter depth 

45mm. 
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23. Select surface as shown below, create new sketch on selected surface 

24. Go to feature toolbar, select Extruded cut, select depth such that all middle part is removed. 

25. To draw 4 circles of diameter 10mm, select surface as shown below and draw two circles. 

 
26. Go to feature toolbar, select Extruded cut, select depth of cut such that circle is cut through 

both upper and lower plate. 
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27. Go to feature toolbar, select fillet, enter fillet radius 5 mm. click on  thick icon. 

 
 

28. To draw Rib, Select Front Plane, and draw line as shown below 
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29.Go to feature toolbar, select Rib  , enter rib thickness 6mm, save this model to 

known location. 

30. To draw second object, close first drawing, select new drawing, select Front Plane, prepare drawing 

as shown below. 

 

31. Go to feature toolbar, select Extruded Boss/Base, click on selected contours, select 

closed area as shown below, select mid plane at Direction 1, enter depth 90mm. click on  thick icon. 
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32. Select sketch file, below to Boss- Extrude1,  located at Feature manager Design tree. 

 

33. Go to feature toolbar, select extrude boss/Base, click on selected contours, choose closed area, select 

mid plane as direction1, enter depth 70mm. click on  thick icon. 
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34. Select Top surface as shown below, and prepare new sketch. 

35. Go to feature toolbar, select extruded Boss/Base, enter depth 30mm. 

 

36. Select top of circle, create new sketch, draw circle of diameter 30mm, select Extruded cut, select 

through all at direction 1, click on  thick icon. 

 

37. To draw rib, select front plane, select line command, prepare sketch as shown below 
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38. Go to feature toolbar, select rib, enter rib thickness 10mm. 

 

 

39.  To mirror rib to opposite side, select recently drawn rib from feature manager design tree, go to 

feature toolbar, select mirror, select right plane as mirror plane  
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40. To draw circle of diameter 10mm, select surface as shown below, draw 2 circles, select Extruded 

cut. 

 

41. Mirror these two circle about right plane. Save this drawing to known location. 

 

42. To prepare Views and to print drawing, create New Drawing as shown below, select previously 

created template. 

    

43. Go to Drawing Toolbar, Select Model view command, file manager will open, now select previously 

saved 3D model and place on sheet, Front view will generate, move pointer in upward direction to 

generate Top view. 
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44. To import annotation, click on generated view, click on import annotation option in property 

manager. 

45. To change display style, go to property manager, display style, we can choose wire frame, Hidden 

line visible, shaded with edges etc. 

46. Size of view can be changed using scale option in property manager. 

47. Additional annotations can be added if required using smart dimensions. 

48. Save drawing to known location, to take print out click on print icon located at top, click on page 

setup, select suitable page size (i.e. A3, A4 etc.), See preview of print, click on print. 
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XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. Explain application of solid Modelling in industry. 

2. List different types of tool bar used in part Modelling. 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

• NPTEL Solid Modelling- 

https://archive.nptel.ac.in/content/storage2/courses/112106061/Module_2/Lecture_2.1.pdf 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No. 05 *Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool 

Post/ any assembly consisting of at least five parts. (Problem-I) 

I. Practical Significance 

Drawing and plotting the production drawing of 3D part models of assemblies such as a 

Bench Vice, Drill Jig, Screw Jack, or Tool Post helps students and engineers understand the 

complete design process from individual part creation to final assembly. It develops skills in 

3D Modelling, dimensioning, tolerance specification, and standard drafting practices. This 

exercise ensures accuracy in manufacturing, improves visualization of mechanical systems, 

and enhances the ability to communicate design intent effectively for real-world production 

and assembly. 

II. Industry/Employer Expected Outcome (s) 

Students should be able to create accurate 3D part models and production drawings of mechanical 

assemblies (like Bench Vice, Drill Jig, Screw Jack, or Tool Post) using CAD tools, interpret 

design requirements, and produce industry-standard documentation for manufacturing and 

assembly. 

III.     Course Level Learning Outcome (CO) 

                         CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

                      CO2-Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

        CO4- Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

Students will be able to create and plot accurate production drawings of 3D part models and 

assemblies (e.g., Bench Vice, Drill Jig, Screw Jack, Tool Post) using CAD tools, demonstrating 

understanding of dimensions, tolerances, and assembly relationships. 

V. Relative Affective Domain Related Outcome(s)- 

Develops interest, discipline, and responsibility in creating accurate production drawings and 

fosters teamwork, attention to detail, and appreciation for engineering design standards. 

VI. Minimum Theoretical Background with diagram 

            Basic knowledge of reading of 3D objects. 

            Knowledge of creating working directory. 

            Basic knowledge of preparation of 2D sketches 
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VII. Experimental setup  

The experimental setup involves a CAD workstation with 3D Modelling software (like 

CATIA, SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students 

create and assemble 3D models of individual components of mechanical devices such as a bench 

vice, drill jig, screw jack, or tool post. The setup includes necessary input devices (mouse, 

keyboard), plotting/printing tools, and reference technical 

VIII. Required Resources /Apparatus/Equipment with specification. 

 

S. 

No. 

Name of 

Resource 
Name of Resource 

Suggested Broad 

Specification 
Quantity 

 

1 

Hardware: 

Personal 

computer 

(i5 or higher), RAM 

minimum 4 GB; A3 / A4 

size printer / plotter. 

Display-wide Screen 

preferably. 

As per batch size 

Hardware: 

Personal 

computer. 

2 
Operating 

system 

Windows XP/Windows 7/ 

Windows 8/Windows 10 or 

higher. 

As per batch size Operating system 

3 Software 
Any parametric solid 

Modelling software. 
As per batch size Software 

4 Plotter. Plotter A2 OR A3Size. 1 Plotter. 

IX. Precautions to be followed 

• Student should understand and can visualize at least two Orthographic views of any 

model. 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While using Sweep or Helical sweep command, need to draw reference axis, reference 

line, trajectory and helical sweep section. This activity should do carefully. 

• While constructing the drawing, periodically save your work. 

X. Procedure 

Use the given orthographic views to create solid model. 

 
JAW SCREW 
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A. Modelling Jaw Screw  

1. Open the 3D CAD software.  

2. Set working directory. 

3.Go to file and select new. 

4.Select part Modelling option. 

5.Give the name Jaw Screw to the new file. 

6.Click on sketch tool and select plane to sketch on (if available front plane). 

 

7.Sketch the profile as shown below (circle of diameter 18). 

 
8.Click ok. 

9.You will return to part environment. 

10.Select extrude/protrude tool and select sketch just created 

as sketch for protrusion. 

11.Enter extrusion dimension as 24 and press ok. You will 

get the model as below. 

 

 
12. Again, select the sketch tool and select any flat face of the 

cylinder just created as sketching plane. 

13.Sketch the profile as shown below (circle of diameter 12). 
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14.Click ok. 

15.You will return to part environment. 

16.Select extrude/protrude tool and select sketch just created as sketch for protrusion. 

17.Enter extrusion dimension as 10 and press ok. You will get the model as below. 

 

 
 

18. Again, select the sketch tool and select a flat face cylinder just created as sketching plane 

 

19. Sketch the profile ns shown below (circle of diameter 16) 



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 67  

 

 
20.Click ok. 

21.You will return to part environment.  

22.Select extrude/protrude tool and select sketch Just created as sketch for protrusion. 

            23.  Enter extrusion dimension as 82 and press ok. You will get the model as below. 

 
24. Again, select the sketch tool and select any flat face of the cylinder just created as sketch 

plane. 

25. Sketch the profile as shown below (circle of diameter 12)  

 

 
 

26. Click OK. 

27. You will return to part development. 

28. Select extrude/protrude tool and select sketch just created as sketch for protrusion. 
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29. Enter extrusion dimensions as 11 press ok you will get the model as below. 

 
30. Again, select the sketch tool and select any fiat face of the cylinder just created as sketching 

plane.  

31.Sketch the profile as shown below (circle of diameter 8). 

32. Click ok. 

33. You will return to part environment. 

 
 

34. Select extrude/protrude tool and select sketch just created as sketch for protrusion. 

35. Enter extrusion dimension as 5 and press ok. You will get the model as below. 
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36. Again, select the sketch tool and select any flat face of the cylinder just created as sketching 

plane. 

37. Sketch the profile as shown below (circle of diameter 12). 

 
 

38.  Click ok. 

39.  You will return to part environment. 

40.  Select extrude/protrude tool and select sketch just created as sketch for protrusion. 

41.  Enter extrusion dimension as 6 and press ok. You will get the model as below. 

 
42.  Now select the hole tool and select the 

 

 

 

Reference plane (vertical or horizontal) bisecting the entire model created. 
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43.  Place the hole of diameter 6 using placement option to satisfy conditions given in   

             drawing and click ok. 

44.  You will get the model as bellow. 

 
 

45.  Save the model. 

 

• Print drawing of the part: 

1. Go to File → Print / Print Preview. 

2. Select Printer or PDF Writer (e.g., Microsoft Print to PDF). 

3. Under Print Range, choose Current Sheet or All Sheets. 

4. Set: 

o Paper size (A4/A3) 

o Orientation (Landscape/Portrait) 

o Scale to 1:1 or Fit to Sheet 

5. Click OK / Print. 

6. Save as .pdf or directly print. 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 
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Questions: 

1.  State the meaning of mmns, mmks. 

2.  List different uses of mouse buttons 

3. Explain the commonly used file formats for saving 3D CAD parts and 2D production 

drawings, and discuss the advantages and limitations of each format. 

4.  Describe the procedure for creating and editing a title block in a CAD drawing sheet.  

5. Explain the factors that influence the selection of scale for plotting a production 

drawing. 

6. Demonstrate how the title block can be customized to include company-specific 

information. 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

1.  https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No.06   *Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ any 

assembly consisting of at least five parts. (Problem-I continued). 

I. Practical Significance 

Drawing and plotting the production drawing of 3D part models of assemblies such as a Bench 

Vice, Drill Jig, Screw Jack, or Tool Post helps students and engineers understand the complete 

design process from individual part creation to final assembly. It develops skills in 3D Modelling, 

dimensioning, tolerance specification, and standard drafting practices. This exercise ensures 

accuracy in manufacturing, improves visualization of mechanical systems, and enhances the 

ability to communicate design intent effectively for real-world production and assembly. 

II. Industry/Employer Expected Outcome (s) 

Students should be able to create accurate 3D part models and production drawings of mechanical 

assemblies (like Bench Vice, Drill Jig, Screw Jack, or Tool Post) using CAD tools, interpret 

design requirements, and produce industry-standard documentation for manufacturing and 

assembly. 

III.   Course Level Learning Outcome (CO) 

            CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

            CO2-Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

             CO4- Plot a drawing for given part model/ assembly. 

IV.  Laboratory Learning Outcome(s) 

Students will be able to create and plot accurate production drawings of 3D part models and 

assemblies (e.g., Bench Vice, Drill Jig, Screw Jack, Tool Post) using CAD tools, demonstrating 

understanding of dimensions, tolerances, and assembly relationships. 

V.   Relative Affective Domain Related Outcome(s)- 

Develops interest, discipline, and responsibility in creating accurate production drawings and 

fosters teamwork, attention to detail, and appreciation for engineering design standards. 

VI. Minimum Theoretical Background with diagram 

• Basic knowledge of reading of 3D objects. 

• Knowledge of creating working directory. 

• Basic knowledge of preparation of 2D sketches 

VII. Experimental setup  

The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 
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SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill 

jig, screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), 

plotting/printing tools, and reference technical drawings for accurate production drawing 

creation. 

VIII. Resources Required 

 

Sr. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; A3 / A4 

size printer / plotter. 

Display-wide Screen preferably. 

As per batch size 

2 Operating system 
Windows XP/Windows 7/ Windows 8/Windows 

10 or higher. 
As per batch size 

3 Software Any parametric solid Modelling software. As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX. Precautions to be Followed 

• Student should understand and can visualize at least two Orthographic views of any 

model. 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While using Sweep or Helical sweep command, need to draw reference axis, reference 

line, trajectory and helical sweep section. This activity should do carefully. 

• While constructing the drawing, periodically save your work. 

 

X. Procedure 

 

▪ Base Plate 

Modelling Base Plate 

DRILL 6.5 C SUNK 4  

JB  56 
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1. Open the 3D CAD software. 

2. Set the working directory. 

3. Go to file and select new. 

4. Select pan Modelling option. 

5. Give the name base_ plate stop to the new file. 

6. Click on sketch tool and select plane to sketch on (if available front plans) 

7. Sketch the profile as shown below.  

144

20

 

 

8. Click ok. 

9. You will return to part environment. 

10.  Select extrude/protrude tool and select sketch just created as sketch for protrusion. 

11.  Enter extrusion dimension as 6 and press ok. You set the model as below. 

 

 
 

12.Select the hole tool and select any flat face of the plate just created as placement plane 

for the hole. 

  13. Select the hole with counter sunk with counter sunk angle as 90º. Diameter of hole as 

6.5. And depth as through all option. Using the placement option place the hole at proper 

position as per drawing. 
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14.Select the hole just created and click on the pattern tool to create similar hole. 

15. Create another instance at a distance of 70 from original hole. The mode) will look like 

a as 

16. Save the model. 

 
B.  Screw Bar 

 

 

 

 

 

 

 

 

 

Modelling Screw Bar 

1. Open the 3D CAD software 

2. Set the working directory. 

3. Go to file and select new 

4. Select part Modelling option 

5. Give the name screw bar to the new file. 

6. Click on sketch tool and select plane to sketch on (if available front plane) 

7. Sketch the profile as shown below 

(circle of diameter 4). 

 
8. Again, select the sketch tool and select any flat face of the cylinder just created as 

sketching 
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9. Sketch the profile as shown below (circle of diameter 6) 

. 

 
 

10. Click ok. 

11. You will return to part environment. 

12. Select extrude / protrude tool and select sketch just created as sketch for protrusion. 

13. Enter extrusion dimension as 104 and press ok. You will get the model as below. 
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14. Again, select the sketch tool and select a flat face of the cylinder just created as sketching   

plane. 

 

 
 

15. Sketch the profile as shown below (circle of diameter 4). 

 
 

16. Click ok. 

17. You will return to part environment. 

18. Select extrude / protrude tool and select sketch for protrusion. 

19, Enter extrusion dimensions as 10 and press ok. You will get the model as below. 

 

 
20. Save the model 

• Print drawing of the part: 

7. Go to File → Print / Print Preview. 

8. Select Printer or PDF Writer (e.g., Microsoft Print to PDF). 

9. Under Print Range, choose Current Sheet or All Sheets. 

10. Set: 

o Paper size (A4/A3) 
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o Orientation (Landscape/Portrait) 

o Scale to 1:1 or Fit to Sheet 

11. Click OK / Print. 

12. Save as .pdf or directly print. 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

                 1.  Define assembly drawing and explain its importance in manufacturing. 

                 2. Distinguish between part drawing and assembly drawing with examples. 

                 3. Explain the advantages of using assembly modelling in product design. 

                 4. List the essential information included in a part drawing. 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

o https://youtu.be/FarPat6WOrM 

o https://youtu.be/esxImdHicOk?si=XEFA1wtkQGUQis4i 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No.07 *Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ any 

assembly consisting of at least five parts. (Problem-I continued). 

 

I.  Practical Significance 

Drawing and plotting the production drawing of 3D part models of assemblies such as a Bench 

Vice, Drill Jig, Screw Jack, or Tool Post helps students and engineers understand the complete 

design process from individual part creation to final assembly. It develops skills in 3D 

Modelling, dimensioning, tolerance specification, and standard drafting practices. This 

exercise ensures accuracy in manufacturing, improves visualization of mechanical systems, 

and enhances the ability to communicate design intent effectively for real-world production 

and assembly. 

II. Industry/Employer Expected Outcome (s) 

Students should be able to create accurate 3D part models and production drawings of mechanical 

assemblies (like Bench Vice, Drill Jig, Screw Jack, or Tool Post) using CAD tools, interpret design 

requirements, and produce industry-standard documentation for manufacturing and assembly. 

III.  Course Level Learning Outcome (CO) 

           CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

           CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

             CO4- Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

Students will be able to create and plot accurate production drawings of 3D part models and 

assemblies (e.g., Bench Vice, Drill Jig, Screw Jack, Tool Post) using CAD tools, demonstrating 

understanding of dimensions, tolerances, and assembly relationships. 

V.   Relative Affective Domain Related Outcome(s)- 

Develops interest, discipline, and responsibility in creating accurate production drawings and 

fosters teamwork, attention to detail, and appreciation for engineering design standards. 

VIII. Minimum Theoretical Background with diagram 

• Basic knowledge of reading of 3D objects. 

• Knowledge of creating working directory. 

• Basic knowledge of preparation of 2D sketches 
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IX. Experimental setup  

• The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 

SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill 

jig, screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), 

plotting/printing tools, and reference technical drawings for accurate production drawing 

creation. 

VIII. Resources Required 

 

S. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; A3 / 

A4 size printer / plotter. 

Display-wide Screen preferably. 

As per batch size 

2 Operating system 
Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 
As per batch size 

3 Software Any parametric solid Modelling software. As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX. Precautions to be Followed 

• Student should understand and can visualize at least two Orthographic views of any 

model. 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While using Sweep or Helical sweep command, need to draw reference axis, reference 

line, trajectory and helical sweep section. This activity should do carefully. 

• While constructing the drawing, periodically save your work. 

 

X. Procedure 

 

A. Sliding Jaw Stop 
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• Modelling Sliding Jaw Stop 

1.Open the 3D CAD software 

2.Set the working dictionary 

3. Go to the file and select new 

4.Select solid part Modelling option 

5.Give name sliding jaw stop to the new file 

6.Click on sketch tool and select plane to sketch on (if available front plane) 

7.Sketch the profile as shown below (Square 32 *32) 

 

32

32
 

 

8.Click ok. 

9. You will return to port environment 

  10.Select extrude /protrude tool and select sketch just created as sketch for protrusion. 

  11. Enter extrusion dimension as 7 and press ok you will set the model as below. 
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12.Select the hole tool and select any flat face of the plate just created as placement plane for 

the hole. . 

  13. Select the hole with counter sunk with counter sunk angle as 90°. Diameter of hole as 6 

         And depth as through all option. Using the placement option place the hole at proper position as 

per drawing. 

 

 

s 

 

  14.Select the hole just created and click on the pattern tool to create similar hole. 

15.Create another instance at a distance of 16 from original hole. The model will look like as 

below 
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16. Save the model 

 

17. Vice Body 

 

 
 

Modelling vice Body 

1. Open the 3D CAD software. 

2. Set the working directory. 

3. Go to file and select new. 

4. Select part Modelling option. 

5. Give the name vice body to the new file. 

6. Click on sketch tool and select plane to sketch on (if available front plane). 

7. Sketch the profile as shown below. 

 

8. Select done. 

9. You will return to part Modelling environment. 

10. Select extrude/protrude tool. 

11. Enter extrude/protrude dimension as 64 and press enter. 

12. You will get the model as below 
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13. Again, select sketch tool and choose the sketching plane as shown below. 

 

 

 
 

14. draw the sketch as shown below. 

 

 
 

15. Finish /ok. 

16. Click on extrude/protrude tool and choose the sketch just created for extrusion/      

 Protrusion. 
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17. Enter 22 as extrusion dimension and click ok. 

18. You will get the model as below. 

 

 
19. Again, select sketch tool and choose the sketching plane as shown below. 

 

 
 20.  Draw the sketch as shown below. 

 

 

 

 
21. Select finish/ok. 

22. Click on extrude/protrude/cutout tool and choose the sketch just created for extrusion/   

 Protrusion. 

23. Select remove material option and select through all option for depth of cut and click ok. 

24. You will get the model as below 
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25. Select the hole option and select hole placement plane and shown below 

 

 
 

26. Select hole type as tapped, M16x2, 

27. Select through next option for depth of the hole. 

28. Place the hole at the center of the circular profile by choosing placement options and  

click ok. 

29. The model will look like as below 

 

 
30. Again, select the hole option and select hole placement plane and shown below (bottom  

 surface of the model) 

 
 



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 91  

 

 

31. Choose tap hole option and select M6x1 as a thread type. 

32. Select hole depth as blind and enter depth value as 12 

33. Choose drill hole profile so as to get tool profile at the bottom of the hole. 

34. Place the hole by using placement option as shown in figure and click ok 

 

 
 

 

35.     Now select hole Just created and click on pattern tool 

36.      Enter no of instances along horizontal direction as 2 and distance between them as 70. No of     

            instances along vertical as two and distance between them as 44. Click ok. 

 

 
 

37. The model will look like as below from bottom 

 

 

 
 

38.  Choose the round tool and select the two edges as below to add a round. Enter round diameter  

        as 3 and press ok. 
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39.  Your mod& of vice body Is complete. Save the work. It will look like es below 

 

 
 

Print drawing of the part: 

13. Go to File → Print / Print Preview. 

14. Select Printer or PDF Writer (e.g., Microsoft Print to PDF). 

15. Under Print Range, choose Current Sheet or All Sheets. 

16. Set: 

o Paper size (A4/A3) 

o Orientation (Landscape/Portrait) 

o Scale to 1:1 or Fit to Sheet 

17. Click OK / Print. 

18. Save as .pdf or directly print. 

 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

 

Questions:  

       1.  Explain the importance of geometric constraints in 3D modelling and how they affect the 

design process. 

2. Describe the purpose of using sectional views in production drawings and how they help   

    in conveying detailed information. 

3.  How do you identify mating parts in an assembly? 

 

[Space for Answer] 

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 93  

 

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 94  

 

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------- 

 

 

XII. References / Suggestions for Further Reading 

• https://youtu.be/QX-ZgTHyNzc?si=ZZGhKFuTFvtvlpVq 

• https://youtu.be/DiJvQ_Dq19Q 

 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No.08 *Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ any 

assembly consisting of at least five parts. (Problem-I continued). 

I. Practical Significance 

Drawing and plotting the production drawing of 3D part models of assemblies such as a Bench 

Vice, Drill Jig, Screw Jack, or Tool Post helps students and engineers understand the complete 

design process from individual part creation to final assembly. It develops skills in 3D Modelling, 

dimensioning, tolerance specification, and standard drafting practices. This exercise ensures 

accuracy in manufacturing, improves visualization of mechanical systems, and enhances the 

ability to communicate design intent effectively for real-world production and assembly. 

II.   Industry/Employer Expected Outcome (s) 

Students should be able to create accurate 3D part models and production drawings of mechanical 

assemblies (like Bench Vice, Drill Jig, Screw Jack, or Tool Post) using CAD tools, interpret 

design requirements, and produce industry-standard documentation for manufacturing and 

assembly. 

III.   Course Level Learning Outcome (CO) 

CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

  CO4- Plot a drawing for given part model/ assembly. 

IV.  Laboratory Learning Outcome(s) 

Students will be able to create and plot accurate production drawings of 3D part models and 

assemblies (e.g., Bench Vice, Drill Jig, Screw Jack, Tool Post) using CAD tools, demonstrating 

understanding of dimensions, tolerances, and assembly relationships. 

V.   Relative Affective Domain Related Outcome(s)- 

Develops interest, discipline, and responsibility in creating accurate production drawings and 

fosters teamwork, attention to detail, and appreciation for engineering design standards. 

VI. Minimum Theoretical Background with diagram 

• Basic knowledge of reading of 3D objects. 

• Knowledge of creating working directory. 

• Basic knowledge of preparation of 2D sketches 

VII. Experimental setup  

The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 
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SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill 

jig, screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), 

plotting/printing tools, and reference technical drawings for accurate production drawing 

creation. 

VIII. Resources Required 

 

Sr. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

Hardware: 

Personal 

computer. 

(i5 or higher), RAM minimum 4 GB; A3 / A4 size 

printer / plotter. 

Display-wide Screen preferably. 

As per batch 

size 

2 Operating system 
Windows XP/Windows 7/ Windows 8/Windows 

10 or higher. 

As per batch 

size 

3 Software Any parametric solid Modelling software. 
As per batch 

size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX. Precautions to be Followed 

• Student should understand and can visualize at least two Orthographic views of any 

model. 

• Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

• While using Sweep or Helical sweep command, need to draw reference axis, reference 

line, trajectory and helical sweep section. This activity should do carefully. 

• While constructing the drawing, periodically save your work. 

 

X. Procedure 

B. Vice Jaw 
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Modelling Vice Jaw 

1. Open the 3D CAD software. 

2. Set the working directory. 

3. Go to the file and select new. 

4. Select part Modelling option. 

5. Give the name vice jaw to the new file.  

6. Click on sketch tool and select plane to sketch on (if available front plane) 

7. Sketch the profile as shown below, 

8. Select done. 

9. You will return to part Modelling environment. 

 

 
10. Select extrude/protrude tool. 

11. Enter extrude/protrude dimensions as 10 and press enter. 

12. You will get the model as below. 
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13. Again, select tool and choose the sketching plane as shown below. 

 
14. Draw the sketch as shown below. 

15. Select finish/ok. 
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16. Click on extrude/protrude tool and choose the sketch lust created for extrusion / protrusion. 

17. Enter 22 as extrusion dimension and cock ok. 

18. You will get the modal as below 

 
19. Select the hole option and select hole placement plane and shown below. 

 
20. Select hole type as simple blind. 

21. Enter the hole depth as 24 and diameter as 12. 

22. Choose drill hole profile so as to get tool profile at the bottom of the hole. 
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23. Place the hole at the center of the circular profile and click ok.  

24. The model will look like as below. 

 
 25. Again, select hole option and select hole placement plane as shown below. 

 

 



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 101  

 

 
 26. Choose hole as standard tapped hole with M4x.5 thread and select hole depth as through next. 

 27. Select counter bore option and enter counter bore depth as 4 

  28. Place the hole at the center of round profile by using placement option. Click ok. 
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29. The model will look as below. 

 

 
 

30. Again, select hole tool and select bottom surface of model as hole placement surface. 
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31. Choose hole as standard tapped hole with M6x.5 thread and select hole as blind with depth   

      as 16. 

32. Place the hole using placement option so as it should match the criteria in the drawing given. 

33. Click ok. 

 
 

 

 34. Now select the hole Just created and click on pattern tool for creating another similar hole. 

 35. Enter no of instances as two and enter distance between two instances as 18 and select ok. 
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36. Now select round tool and choose two edges as below foe adding round of R3. 

37. Your model of vice jaw is complete. Save the work. 

Print drawing of the part: 

19. Go to File → Print / Print Preview. 

20. Select Printer or PDF Writer (e.g., Microsoft Print to PDF). 

21. Under Print Range, choose Current Sheet or All Sheets. 

22. Set: 

o Paper size (A4/A3) 

o Orientation (Landscape/Portrait) 

o Scale to 1:1 or Fit to Sheet 

23. Click OK / Print. 

24. Save as .pdf or directly print. 

 

 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions so as to ensure the achievement of identified CO. 

1. Identify a 3D Modelling software you have used in mechanical design experiments. Explain its 

primary features and advantages in creating mechanical components. 

2.  Explain the step-by-step procedure for creating a solid model of a mechanical component using 

CAD software. Include the sequence of operations from sketching to final solid creation. 

3.  List and describe the CAD commands used for sketching a profile and extruding it into a 3D solid 

part. Demonstrate their application with an example of a simple mechanical component. 

4.  Explain how geometric and dimensional constraints are applied in a CAD sketch. Illustrate with an 

example how constraints ensure the accuracy and design intent of a mechanical component. 
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XII. References / Suggestions for Further Reading 

• https://youtu.be/x_eLhRKHqLw?si=7HUy6RSrtLcO2YFE 

• https://youtu.be/DiJvQ_Dq19Q 

•       Rubrics for Assessment Scheme 

 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No. 09 * Assembly and plotting the orthographic views of the assembly, 

bill of materials of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ any assembly 

consisting of at least five parts. (Problem-I) 

I. Practical Significance. 

This practical helps students understand the complete assembly process of mechanical 

components such as a Bench Vice, Drill Jig, Screw Jack, or Tool Post. It develops the ability 

to interpret, assemble, and visualize 3D parts, and to create orthographic views and a Bill of 

Materials (BOM) accurately. This skill is essential for manufacturing, design 

communication, and production documentation in engineering practice. 

II. Industry/Employer Expected Outcome (s) 

a. Ability to interpret and create assembly and orthographic drawings accurately. 

b. Understanding of mechanical assembly relationships and fit between components. 

c. Proficiency in using CAD software for assembly Modelling and 2D documentation. 

d. Readiness to work in design, drafting, and manufacturing environments with proper 

technical drawing standards. 

III. Course Level Learning Outcome (CO) 

                         CO1 - Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

                      CO2-Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

                      CO3 - Prepare assembly of part models using given 3D Modelling software. 

       CO4- Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

a. Understand the assembly and working of mechanical components. 

b. Develop skill in assembling parts and creating orthographic views. 

c. Gain proficiency in CAD tools for Modelling and drafting. 

d. Interpret and apply engineering drawing standards in practical work. 

V. Relative Affective Domain Related Outcome(s)- 

a. Develop attention to detail and accuracy in technical work. 

b. Foster teamwork, discipline, and responsibility during assembly tasks. 

c. Build appreciation for engineering design and drafting standards. 
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d. Cultivate patience and problem-solving attitude while completing assemblies. 

e. Encourage professional ethics and safety awareness in laboratory practice. 

VI. Minimum Theoretical Background with diagram 

a. Assembly Concept: - Combining individual components to form a functional unit. 

b. Orthographic Projection: - Used to represent 3D assemblies on 2D planes (Front, Top, 

Side views). 

c. Example – Screw Jack Assembly: - A screw jack is a mechanical device used to lift 

loads using a screw mechanism. 

Main parts: - Base, Body, Screw, Nut, and Handle. 

VII. Experimental setup  

The experimental setup involves a CAD workstation with 3D Modelling software (like 

CATIA, SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students 

create and assemble 3D models of individual components of mechanical devices such as a 

bench vice, drill jig, screw jack, or tool post. The setup includes necessary input devices 

(mouse, keyboard), plotting/printing tools, and reference technical. 

 

VIII. Required Resources /Apparatus/Equipment with specification. 

 

Sr. 

No. 

Name of 

Resource 
Suggested Broad Specification Quantity 

 

1 

Hardware: 

Personal 

computer 

(i5 or higher), RAM minimum 8 GB; A2/A3 / 

A4 size printer / plotter. 

Display-wide Screen preferably. 

As per batch size 

2 
Operating 

system 

Windows XP/Windows 7/ Windows 

8/Windows 10 or higher. 
As per batch size 

3 Software Any parametric solid Modelling software. As per batch size 

4 Plotter. Plotter A2 OR A3Size. 1 

 

IX. Precautions to be Followed 

• Understand all parts before assembly. 

• Follow correct scale and dimensions. 

• Use standard drawing conventions (lines, projection). 

• Align views properly (front, top, side). 

• Assemble in correct sequence. 

• Avoid overcrowding of views and dimensions. 
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• Ensure proper fit and clearance between parts. 

• Cross-check everything before assembly. 

 

X. Procedure 

Note: - Use the 3D parts created in Experiment No.5,6,7 and 8. 

1. Open the 3D CAD software. 

2. Set working directory. 

3. Go to the file and select new. 

4. Select assembly Modelling option. 

5. Give the name bench vice assembly to the new file. 

6. Select and component to the assembly option.  

7. An open dialog box will pop up. 

8. Browse the location where you have saved vice body model in experiment no. 7. 

9. Clock on open. 

10. The vice body part will be inserted in the assembly. 

11. Select the placement option as fix (fix component position) and press OK.  

(the vice body is assumed to be base component for assembly) 

 
  

12. Now again select and component to the assembly option to add another component. 

13. Browse to the vice jaw in experiment no.8. 

 

 
14.Select the MATE placement relation from the placement tool and click the surface to mate. 
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15.The vice body will be oriented as below. 

 

 

 
 

16. select the offset option and enter value of 0.25. 

 

 
17. again select MATE placement option and select different planes as shown below on vice_ body 

and vice jaw to mate. 

 

 
18. The model will be appear as shown below. 
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19. Now the vice_ Jaw is fully constrained to the vice_ body. the motion possible in vice_ jaw in 

relation to vice_ body is only sliding. 

20.Select the MOVE option and press and holding left mouse button slide the vice_ jaw to 

convenient position as shown below. 

 

 
 

21. Click on ok 

22. Again, select add component to the assembly option. 

23.Browse the location where you have saved jaw_ screw model in experiment no.5 and press 

open. 

 

 

 
24. Select INSERT placement option and select cylindrical portion of the jaw_ screw and hole 

in the vice_ body for INSERT. 
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25. The assembly will look like as below. 

 

 
26. if the jaw screw is oriented in wrong direction as above click on FLIP INSERT 

CONSTRAINTS or select opposite cylindrical portion to insert. 

 

27. The assembly will look like as below. 

 

 
28. Repeat the procedure with INSERT placement option with jaw_ screw and hole of vice jaw   

      and by using move option adjust the position of jaw screw as shown below.  
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29.  Click on ok 

30. Again, select add component to the assembly option. 

31. Browse the location where you have saved screw bar model in experiment no.6 and press 

open. 

 

 
32. Repeat the procedure with INSERT placement option with screw bar and hole of jaw screw   

      and by using move option adjust the position of jaw screw as shown below.  

33. The assembly will appear as below. Save the work 

 
 

 
Print drawing of the part: 

1. Go to File → Print / Print Preview. 

2. Select Printer or PDF Writer (e.g., Microsoft Print to PDF). 

3. Under Print Range, choose Current Sheet or All Sheets. 

4. Set: 

o Paper size (A4/A3) 

o Orientation (Landscape/Portrait) 

o Scale to 1:1 or Fit to Sheet 

5. Click OK / Print. 

6. Save as .pdf or directly print. 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more 

such questions so as to ensure the achievement of identified CO. 

Questions: 

1.  State the meaning of MMNS and MMKS. 

2. List the different uses of mouse buttons in CAD software. 

3.  Explain the procedure to create and edit a title block in a drawing sheet. 

4. State the scale decided while plotting the production drawing? 
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[Space for Answer] 
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XII. References / Suggestions for Further Reading 

1.  https://www.youtube.com/watch?v=XlsaSe444AE 

2. https://www.youtube.com/watch?v=b6b9FY14PKw 

3. https://www.youtube.com/watch?v=X0AMdUMNsDI 

XIII.     Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No: 10   Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ 

any assembly consisting of at least five parts. (Problem-II, Part 1) 

I. Practical Significance 

    This practical helps students develop skills in 3D solid Modelling, enabling them to 

create, visualize, and assemble machine components accurately. It enhances design 

understanding, creativity, and manufacturing readiness through model visualization and 3D 

printing. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1. Prepare 3D model of given object. 

2. Prepare 2D Darwing from given 3D model 

3. Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Develop 3D model of components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings and 

3D models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). 

Solid Modelling Techniques- Extrusion: Extending a 2D profile to create a 3D solid, Revolution: 

Rotating a sketch around an axis to form symmetrical shapes, Sweeping & Lofting: Creating 

complex shapes by moving profiles along paths, Boolean Operations: Combining or subtracting 

solids (Union, Subtract, Intersect). Reference planes (XY, YZ, ZX) and axes are used to define 

model geometry accurately. 2D Drawing Generation- Orthographic, isometric, and sectional views 

are generated from 3D models. Dimensions, tolerances, and annotations are added to communicate 

manufacturing details. 
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VII. Experimental setup (Model)- 

 The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 

SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill jig, 

screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), plotting/printing 

tools, and reference technical. 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

IX.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor. 

X. Procedure 

Problem Definition: 

a. Prepare 3D part model of figure 10.1 given below 

b. Prepare Front view and Top view of figure 10.1 

 
Figure 10.1: Object for preparing 3D model 
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1.  Open solid modelling software 

2. Click on  new icon. 

3. Click on  part icon for creating new object. 

4. Click on  setting icon located at top. 

5. Select document properties Tab and select units option. 

6. Select MMGS (millimeter, gram, seconds) for setting units in millimeter and click ok. 

7. Go to Feature manager design tree  

 
Feature manager design tree 

8. Select Top plane option located in feature manager design tree. 

 
Planes 

9. Goto to head up view toolbar for rotating view (for bringing selected view to the front) 

 

and click on  view orientation icon, then click  Normal to icon. 

10. Go to feature manager design tree, click on Top plane  and click on  

sketch icon to start new sketch 
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11. Go to sketch tool bar, click on corner rectangle  

 

12. Start from origin and draw one rectangle in selected sketch plane. 

13. Go to sketch toolbar and click on smart dimension icon. 

 
14. Now click on bottom horizontal line, one pop up will appear, enter the length of selected 

line as per given sketch 
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15. Select vertical line and enter dimension as per given drawing. 

 
16. Go to feature tool bar and click on Extruded Boss/Base 

 

17. In property manager enter required depth (18mm) and select direction by clicking  on 

this icon. 

 
 

18. Base of object will look like sample given below 
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19. Now to create middle circular part, we will create new plane at the middle 

20. To create new plane, go to feature toolbar, go to reference geometry icon  and 

click on plane . 

 

21. In property manager, click on first reference and select first face on 3D model as shown 

above 

22. Now to rotate 3D model, click and hold scroll button on mouse and move mouse, click on 

second reference and select opposite face of model as shown below  

 

23. New plane at the middle of model will be visible, click on  this image to create plane 

24. Now rotate the object and click on plane which is created in last step, click on sketch icon 
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25. Rotate the view as per your requirement and draw sketch and center line as show below. 

 
26. Go to smart dimensions and give dimension as shown below. 

 

27. Go to feature tool bar and click on revolve Boss/Base  and select axis of revolution 

in property manager and center line as shown in below, circular object will generate, click 

on  icon to confirm. 
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28. To add fillet of R6 as given in drawing, go to feature manager, go to fillet, click on  

icon 

29. Go to property manager, select fillet type- constant size fillet, select full preview, select 

fillet radius 6, select edge to add fillet 
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30. To add sung recess at top, go to top surface of model and click on surface, click on sketch 

icon to create new drawing 

 

31. Go to sketch toolbar and select line icon  and create rectangle as shown below and 

give smart dimensions. 

 

32. Go to feature toolbar, click on extruded cut  and select dept of cut 
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33. To add pin hole at bottom of body, to rotate view press scroll bar and move mouse and 

select bottom surface inside circular space, click on sketch icon to create new drawing. 

 

34. Go to sketch toolbar and click on circle icon , draw circle and give dimensions. 

 

35. To create hole, go to feature toolbar, click on Extruded cut and select depth of cut 6mm 

36. Create bolt hole at base plate of body as shown below 
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37. Save this drawing to known location. 

38. To generate views and print, close current drawing select New drawing, select previously 

created template. 

    
39. Go to Drawing Toolbar, Select Model view command, file manager will open, now select 

previously saved 3D model and place on sheet, Front view will generate, move pointer in 

upward direction to generate Top view. 

40. Save drawing and take printout as per procedure in experiment number 4, procedure 

number 44 to 48. 
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XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. Explain the concept of parametric modelling. 

2. Describe the difference between solid, surface, and wireframe modelling. 

3. Differentiate between extrude and revolve features with examples. 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

Engineering Graphics and Design, IIT Delhi- Week 8 to week 12: 

https://nptel.ac.in/courses/112102304 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No: 11 Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ 

any assembly consisting of at least five parts. (Problem-II, Part 2) 

I. Practical Significance 

    This practical helps students develop skills in 3D solid Modelling, enabling them to 

create, visualize, and assemble machine components accurately. It enhances design 

understanding, creativity, and manufacturing readiness through model visualization and 3D 

printing. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1. Prepare 3D model of given object. 

2. Prepare 2D Darwing from given 3D model 

3. Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Develop 3D model of components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings 

and 3D models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). 

Solid Modelling Techniques- Extrusion: Extending a 2D profile to create a 3D solid, 

Revolution: Rotating a sketch around an axis to form symmetrical shapes, Sweeping & Lofting: 

Creating complex shapes by moving profiles along paths, Boolean Operations: Combining or 

subtracting solids (Union, Subtract, Intersect). Reference planes (XY, YZ, ZX) and axes are used to 

define model geometry accurately. 2D Drawing Generation- Orthographic, isometric, and sectional 

views are generated from 3D models. Dimensions, tolerances, and annotations are added to 

communicate manufacturing details. 

 



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 130  

 

VII. Experimental setup (Model)- 

  The experimental setup involves a CAD workstation with 3D Modelling software (like 

CATIA, SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students 

create and assemble 3D models of individual components of mechanical devices such as a bench 

vice, drill jig, screw jack, or tool post. The setup includes necessary input devices (mouse, 

keyboard), plotting/printing tools, and reference technical. 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

IX.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor. 

X. Procedure 

Problem Definition: 

a. Prepare 3D part model of figure 11.1 given below. 

b. Prepare Front view and Top view of figure 11.1. 

 

 
Fig11.1: Object for preparing 3D model 
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1.  Open solid modelling software 

2. Click on  new icon. 

3. Click on  part icon for creating new object. 

4. We will draw this object using Revolve Boss/Base command, for that select Front plane and 

prepare drawing with center line as shown below. 

 
5. Go to feature toolbar and select Revolve Boss/Base, select center line as axis of rotation, 

choose direction 1 360 degrees, click on  thick icon. 
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6. To create sung key, rotate object upside down, select surface as shown below and prepare 

sketch 

 

 
 

 
 

7. Use extrude Boss/Base to extrude sung key with depth of 8mm. 
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8. Final object shown below. 

 

 
9. Save this drawing to known location. close current drawing. 
10. Now to create 2D drawing from 3D part model recently created, Open new drawing, choose 

previously created template. 
11. Go to drawing toolbar, go to model view, browse previously saved 3D model, place it on 

sheet, move pointer upward to draw top view. 
12. Import annotations, give smart dimensions, save this drawing, do page setup, take printout 

of drawing. 
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XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. List any four basic sketching tools used in 3D Modelling. 

2. Identify different types of constraints used in part Modelling. 

3. State the use of datum planes in solid Modelling. 

4. Name any two 3D CAD software used for solid Modelling. 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

Overview of CAD/CAM: https://nptel.ac.in/courses/112102102 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 Completion of drawing with minimum size of model 

tree. 

20% 

Product Related (15 Marks) (60%) 

3 Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 

20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 

 

   



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 137  

 

Practical No: 12 Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ 

any assembly consisting of at least five parts. (Problem-II, Part 3) 

I. Practical Significance 

    This practical helps students develop skills in 3D solid Modelling, enabling them to 

create, visualize, and assemble machine components accurately. It enhances design 

understanding, creativity, and manufacturing readiness through model visualization and 3D 

printing. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1. Prepare 3D model of given object. 

2. Prepare 2D Darwing from given 3D model 

3. Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Develop 3D model of components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings 

and 3D models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). 

Solid Modelling Techniques- Extrusion: Extending a 2D profile to create a 3D solid, 

Revolution: Rotating a sketch around an axis to form symmetrical shapes, Sweeping & Lofting: 

Creating complex shapes by moving profiles along paths, Boolean Operations: Combining or 

subtracting solids (Union, Subtract, Intersect). Reference planes (XY, YZ, ZX) and axes are used to 

define model geometry accurately. 2D Drawing Generation- Orthographic, isometric, and sectional 

views are generated from 3D models. Dimensions, tolerances, and annotations are added to 

communicate manufacturing details. 

 



3D Modelling and Additive Manufacturing (316013) 

 

 Maharashtra State Board of Technical Education                                                                                                       K Scheme 

 138  

 

VII. Experimental setup (Model)- 

 The experimental setup involves a CAD workstation with 3D Modelling software (like 

CATIA, SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students 

create and assemble 3D models of individual components of mechanical devices such as a bench 

vice, drill jig, screw jack, or tool post. The setup includes necessary input devices (mouse, 

keyboard), plotting/printing tools, and reference technical. 

 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

IX.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor. 

X. Procedure 

Problem Definition: 

1. Prepare 3D part model of figure 12.1 given below 

2. Prepare Front view and Top view of figure 12.1 

 
Fig 12.1: Object for preparing 3D model 

1.  Open solid modelling software 

2. Click on  new icon. 

3. Click on  part icon for creating new object. 

4. We will prepare this part using Revolve Boss/Base, select front view, draw sketch as shown 

below 
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5. Use Revolve Boss/Base command, select center line as axis of rotation, select direction1 and 

rotate through 360 degrees. 

 

6. click on  thick icon. 

 

 

 
7. To create hole for pin at bottom of disc, rotate disc upside down, select bottom surface and 

draw circle as shown below. 
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8. Create hole using Extruded cut command, select direction of cut, 6mm depth of cut. 
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9. Save this drawing to known location. close current drawing. 

10. Now to create 2D drawing from 3D part model recently created, Open new drawing, choose 

previously created template. 

11. Go to drawing toolbar, go to model view, browse previously saved 3D model, place it on 

sheet, move pointer upward to draw top view. 

12. Import annotations, give smart dimensions, save this drawing, do page setup, take printout 

of drawing. 

 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. Define solid Modelling? How is it different from wireframe and surface Modelling. 

2. Define CAD. List the main features of CAD software used for solid Modelling? 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

An Introduction to CAD: https://nptel.ac.in/courses/112102101 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No: 13 Drawing and plotting the production drawing of the 3D part 

models of individual components of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ 

any assembly consisting of at least five parts. (Problem-II, Part 4) 

I. Practical Significance 

    This practical helps students develop skills in 3D solid Modelling, enabling them to 

create, visualize, and assemble machine components accurately. It enhances design 

understanding, creativity, and manufacturing readiness through model visualization and 3D 

printing. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1. Prepare 3D model of given object. 

2. Prepare 2D Darwing from given 3D model 

3. Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Develop 3D model of components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings 

and 3D models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). 

Solid Modelling Techniques- Extrusion: Extending a 2D profile to create a 3D solid, 

Revolution: Rotating a sketch around an axis to form symmetrical shapes, Sweeping & Lofting: 

Creating complex shapes by moving profiles along paths, Boolean Operations: Combining or 

subtracting solids (Union, Subtract, Intersect). Reference planes (XY, YZ, ZX) and axes are used to 

define model geometry accurately. 2D Drawing Generation- Orthographic, isometric, and sectional 

views are generated from 3D models. Dimensions, tolerances, and annotations are added to 

communicate manufacturing details. 
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VII. Experimental setup (Model)- 

 The experimental setup involves a CAD workstation with 3D Modelling software (like 

CATIA, SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students 

create and assemble 3D models of individual components of mechanical devices such as a bench 

vice, drill jig, screw jack, or tool post. The setup includes necessary input devices (mouse, 

keyboard), plotting/printing tools, and reference technical. 

 

 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

IX.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor. 

X. Procedure 

Problem definition: 

1.Prepare 3D part model of figure 13.1 given below 

2.Prepare Front view and Top view of figure 13.1 

 

                       
Fig 13.1: Object for preparing 3D model 
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1. Open Solid modelling software 

2. Click on  new icon. 

3. Click on  part icon for creating new object. 

4. We will prepare this part using Revolve Boss/Base, select front view, draw sketch as shown 

below 

 

 

 

5. Go to feature toolbar, select Revolve Boss/Base, select center line as axis of rotation, rotate 

through 360 degrees, click on  thick icon. 

 
 

6. To add fillet, go to feature toolbar, select fillet, enter radius 7mm, select surface as shown 

below. 
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7. Save this drawing to known location. 
8. To draw pin, create new part drawing. 

9. Select Top plane, go to sketch toolbar, draw circle as shown below 

 

10. Go to feature toolbar, select Extruded Boss/Base, keep depth 12mm. click on  thick 

icon. 
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11. Go to feature toolbar, select fillet, select fillet radius 2mm as shown below, click on  

thick icon. 

 

 

 
12. Save this file to known location. 
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13. Now to create 2D drawing from 3D part model recently created, Open new drawing, choose 

previously created template. 
14. Go to drawing toolbar, go to model view, browse previously saved 3D model, place it on 

sheet, move pointer upward to draw top view. 
15. Import annotations, give smart dimensions, save this drawing, do page setup, take printout 

of drawing. 

 
 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. What are Boolean operations? Name and explain different Boolean operations. 

2. What is a sweep feature? How does it differ from a loft feature? 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

Engineering Graphics and Design, IIT Delhi- Week 8 to week 12: 

https://nptel.ac.in/courses/112102304 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

 

 

 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No: 14 Assembly and plotting the orthographic views of the assembly, bill 

of materials of Bench vice/ Drill Jig/ Screw Jack/ Tool Post/ any assembly 

consisting of at least five parts. (Problem-II) 

I. Practical Significance 

    This practical helps students develop skills in 3D solid Modelling, enabling them to 

create, visualize, and assemble machine components accurately. It enhances design 

understanding, creativity, and manufacturing readiness through model visualization and 3D 

printing. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1 Prepare 3D model of given object. 

2 Prepare assembly Drawing. 

3 Prepare 2D Darwing from given 3D model 

4 Plot given 2D drawing 

III. Course Level Learning Outcome (CO) 

CO1- Prepare 2D drawing using sketch toolbar of given 3D Modelling software. 

CO2- Prepare 3D solid models from 2D sketch using given 3D Modelling software. 

CO3- Prepare assembly of part models using given 3D Modelling software. 

CO4 - Plot a drawing for given part model/ assembly. 

IV. Laboratory Learning Outcome(s) 

• Assemble the given 3D components from given part drawing. 

• Plot the given components. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

Basic Concepts of CAD- CAD software is used to create, modify, and analyze 2D drawings 

and 3D models. Geometric constraints define relationships between sketch elements (e.g., parallel, 

perpendicular, concentric). Dimensional constraints specify size and proportions (e.g., length, angle, 

diameter). Reference planes (XY, YZ, ZX) and axes are used to define model geometry accurately. 

2D Drawing Generation- Orthographic, isometric, and sectional views are generated from 3D 

models. Dimensions, tolerances, and annotations are added to communicate manufacturing details. 

-Assembly and Constraints: Multiple parts are assembled using mates and constraints such as 

coincident, parallel, and concentric, Ensures correct motion and alignment between components. 
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VII. Experimental setup (Model)- 

 The experimental setup involves a CAD workstation with 3D Modelling software (like CATIA, 

SolidWorks, AutoCAD or Any parametric solid Modelling software.) where students create and 

assemble 3D models of individual components of mechanical devices such as a bench vice, drill jig, 

screw jack, or tool post. The setup includes necessary input devices (mouse, keyboard), plotting/printing 

tools, and reference technical. 

 

VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

 

IX.  Precautions to be Followed 

1. Check given drawing for dimensional printing mistakes if any and if dimensions are 

missing assume proportionate dimensions. 

2. Check whether units are set to mm 

3. While constructing the drawing, periodically save your work. of instructor. 

X. Procedure 

Prepare assembly from 3D part models prepared in Experiment number 10 

 to 13 

1. Open solid modelling software 

2. Click on  new icon. Click on Assembly. 

3.  Go to Assembly toolbar, click on insert components, browse for location where all 3D 

parts from practical number 10 to 13 are saved, select all essential parts, click ok 
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4. Left Click on main object (Body), select option ‘Fix’, this will fix object, make sure all 

other are not fixed. 

5. The sequence of assembly will be Body, Bush, Pin, Disk, Shaft. 

6. Double click on Bush, move bush close to body. 

7. Go to Assembly toolbar, click on Mate, click on Mate selection option located in property 

manager. 

8. Click on circular surface of bush and circular surface of body as shown below, the apply 

concentric constrains, this align both object such that single axis pass through both objects. 

click on  thick icon. 

9. Align sung key in sung key slot, click on Mate selection, click of flat surface of sung key 

on bush and sung key slot as shown below, apply Coincident Constrain. 
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10. The surface of bush and body should make contact, to apply this Constrain, click on Mate 

selection, click on bottom surface of bush and surface of body as shown below, apply 

Coincident Constrain.  

 

 

11. To assemble pin at pin hole, Go to Mate, Mate Selection, click on circular surface of pin 

and pin hole, apply concentric constrain. 

12. Go to Mate selection, click on bottom surface of pin hole and bottom surface of pin, apply 

tangent constrain. 
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13. To assemble disk, go to Mate, Mate selection, click on circular surface of pin and circular 

hole in disk, apply concentric constrain. 

14. Go to Mate, Mate selection, click on outer circular surface of disk and internal circular 

surface of bush, apply concentric constrain. 

15. Go to Mate selection, select bottom surface of body inside circular section and bottom surface 

of disk, apply coincident constrain. 

 
16. Go to Mate, Mate selection, click on outer circular surface of rod and internal circular surface 

of bush, apply concentric constrain. 

17. Mate selection, click on bottom surface of rod and top surface of disk, apply tangent 

constrain. 
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18. Save this drawing to known location. close current drawing. 

19. Now to create 2D drawing from Assembly model recently created, Open new drawing, 

choose previously created template. 

20. Go to drawing toolbar, go to model view, browse previously saved 3D assembly, place it on 

sheet, move pointer upward to draw top view. 

21. Import annotations, give smart dimensions, save this drawing, do page setup, take printout 

of drawing. 

 

 
 

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. Explain Bill of Materials (BOM)? How is it generated in CAD software. 

2. Explain importance of tolerances and fits in solid Modelling drawings. 

 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

Engineering Graphics and Design, IIT Delhi- Week 8 to week 12: 

https://nptel.ac.in/courses/112102304 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 Completion of drawing with minimum size of model 

tree. 

20% 

Product Related (15 Marks) (60%) 

3 Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 

20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 
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Practical No: 15 *Printing any one component from above assembly using 3D 

I. Practical Significance 

    3D part Modelling enables students to design mechanical components accurately in 

a virtual environment before producing them physically. When these digital models are 3D 

printed, students can directly visualize and evaluate their designs in real form. This practical 

bridges the gap between design and manufacturing, helping learners understand the complete 

product development cycle — from concept, Modelling, and visualization to actual 

fabrication. It enhances creativity, accuracy, and problem-solving skills by allowing quick 

design modifications and reprinting. 

II.   Industry/Employer Expected Outcome (s) 

     This practical is expected to develop the following skills for the industry/Employer  

1 Prepare Physical model from given 3D model. 

III. Course Level Learning Outcome (CO) 

CO5- Prepare components of assembly using 3D printer/ rapid prototyping machine. 

IV. Laboratory Learning Outcome(s) 

• 3D Print the given component. 

V. Relative Affective Domain Related Outcome(s)- 

• Follow safety practices.  

• Demonstrate working as a leader/a team member. 

• Maintain tools and equipment. 

• Follow ethical Practices Follow ethical Practices. 

 

VI. Relevant Theoretical Background with diagram 

1. CAD Modelling: Creating accurate 3D geometry with proper dimensions and constraints. 

2. STL File Generation: Converting a 3D model into a mesh suitable for printing. 

3. Slicing Process: Dividing the model into layers and setting parameters such as infill, layer 

height, and print speed. 

4. Additive Manufacturing Principle: Building objects layer by layer rather than removing 

material (as in machining). 

5. Printer Types: FDM (Fused Deposition Modelling), SLA (Stereolithography), and SLS 

(Selective Laser Sintering). 

6. Material Selection: Common materials include PLA, ABS, PETG, and resin, depending on 

strength and surface finish requirements. 

Thus, 3D printing converts digital designs into tangible prototypes, allowing rapid visualization, 

testing, and product improvement. 

VII. Experimental setup (Model)- 

Select any one component prepared in this course and prepare Physical 3D model. 
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VIII. Required Resources /Apparatus/Equipment with specification 

 

Sr. No. Name of Resource 
Suggested Broad 

Specification 
Quantity 

1 Computer Latest configuration 1 for each student 

2 3D modelling software Latest configuration 1 for each student 

3 Plotter/ printer A3 size 1 

4 3D Printer 
Minimum 200x200x200 

work volume 
1 

IX.  Precautions to be Followed 

1. Check for filament wire melting temperature given by manufacturer. 

2. Select suitable built plate temperature. 

3. Check filament wire for any cut, discontinuity. 

X. Procedure 

1. Open any slicer software, if software is newly installed, while initializing select suitable 

model of 3D printer, enter bed Size and Hight of Z axis. If software is already initialized, 

suitable model of 3D printer can be selected using add printer option. 

2. Before importing 3D part model in slicer software, the file must be saved in. stl format. 

3. Import 3D model, using open file option. 
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4. Rotate object such that base of object align with bed. 

 

5. To set Process Parameter Options: Quality, go to print setting, show customs 

i. Layer Height-0.3mm: The thickness of each printed layer is known as the 

Layer Height. The smaller the layer height, the smoother curves will appear. 

Larger layer heights are better for bridging and overhang. Figure shows 

differences in Layer Height 

ii. Initial layer height- The height of the initial layer in mm. A thickener initial 

layer makes adhesion to the build plate easier. Enter 0.4mm initial layer 

height in our job. 

iii. Base Line Width-0.4 mm: This will define how wide your “support” 

material is for the raft. This setting will determine how well the surface 

layers of the raft print. 

iv. Wall line width-This is width of a single wall line and value will be 0.4 mm 

is enough in our case. 

v. Outer wall line thickness-Width of outermost wall line by lowering the 

value. Higher level of value will print detail. Again 0.4 mm is sufficient for 

our case. 

vi. Outer Wall Line Width-Width of outermost wall line. By lowering this 

value, higher level of detail can be printed. Specify 0.4 mm value in our 

case. 

vii. Inner walls line width-0.4 mm. It is width of a single wall line for all wall 

lines except the outermost one. Enter 0.4 mm value for current job. 

viii. Top /bottom line width-0.4 mm width of single top/bottom line. 
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ix. Infill line width -0.4mm 

x. Skirt/Brim line width-0.4 mm 

 

 

6. Go to material any select recommended melting temperature provided by filament 

manufacturer. Select built plate temperature 50 to 60 degree Celsius.  

7. Select support option if there is any hanging part object. 

8. Select printing speed as per recommendation of 3D printer manufacturer. 

9. Click on slice, software will generate tool path layer by layer. 
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10. click on save to disk, transfer this file to 3D printer and start to print.  

XI. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such questions 

so as to ensure the achievement of identified CO. 

1. Explain 3D printing. Compare with traditional manufacturing. 

2. Explain the step-by-step process of converting a 3D model into a 3D printed object. 

3. Explain role of STL file in 3D printing. 

4. Name common materials used for FDM 3D printing. 

 

[Space for Answer] 
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XII. References / Suggestions for Further Reading 

Advances in Additive Manufacturing of Materials: Current status and emerging opportunities, IISc 

Bangalore: https://nptel.ac.in/courses/113108632 

XIII. Rubrics for Assessment Scheme 

 

Performance Indicators Weightage 

Process Related (10 Marks) (40%) 

1 Use proper commands. 20% 

2 
Completion of drawing with minimum size of model 

tree. 
20% 

Product Related (15 Marks) (60%) 

3 
Generation and printing of drawing views, tables, etc. 

and their arrangement on different sheet size. 
20% 

4 Answers to oral questions. 20% 

5 Completion of work in time. 20% 

 Total (25 Marks) 100 % 

 

 

Marks Obtained 
Dated signature 

of Teacher 

Process Related 

(10) 

Product Related 

(15) 
Total (25) 

 

   


